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1.  LeCroy Overview
LeCroy’s SATracer/Trainer™ 3G is an integrated protocol analyzer and 
exerciser platform that provides fast, efficient and accurate debug, test and 
verification of Serial ATA semiconductors, devices and systems.  
SATracer/Trainer platform allows designers and validation engineers to 
quickly and easily transmit valid and invalid 1.5 or 3 Gbps SATA traffic, 
selectively record the exchange and display the results using the LeCroy 
Trace™ expert analysis software.  SATrainer offers both initiator and target 
side emulation modes, allowing this all-in-one test platform to play an 
important role at every phase of the SATA product development process. 

The SATracer and SATrainer software operate on the LeCroy SAS/SATA 
Analyzer and Exerciser platforms.  SATracer is the software that runs the 
SAS/SATA Analyzer plug-in module.  This plug-in module installs into the 
LeCroy 10K platform.  SATrainer is traffic generation software that runs the 
SAS/SATA Exerciser platform.  Together, the Analyzer and Exerciser 
platforms can be used selectively for analysis only, traffic generation only, 
or perform both analysis and traffic generation at the same time.  The 
SASTracer/Trainer can transmit a single link of 1.5 or 3 Gbps traffic while 
providing 1 or 2 recording channels.  A “4-wide” recording option is also 
available to support wide link analysis tasks.

The heart of the CATC platform is the revolutionary LeCroy BusEngine™.  
This state-of-the-art, field-upgradeable, technology core incorporates a 
real-time non-intrusive recording engine and configurable tools to trigger 
and filter SATA traffic.  It can intelligently monitor SATA frame headers 
and addresses; or start recording when event counters exceed specified 
thresholds.  

SATrainer utilizes standard Serial ATA cables and can be programmed to 
transmit valid and invalid SATA traffic.  It can send specific IO operations 
or customized data payloads.  The exerciser can “play-back” any previously 
recorded trace as a stimulus file and also offers a text-based API for creating 
scripts from the ground up. 

As with all LeCroy analyzers, hardware based pre-capture filtering is 
supported for efficient memory management.  

For complete product information, please visit www.LeCroy.com.
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Please refer to the Serial ATA Specification for details on the SATA 
protocol.

1.1  General Description 
SAS/SATA Analyzer and SAS/SATA Exercisers are plug-in modules that 
install into a chassis called the  Universal Protocol Analyzer System 10K 
(UPAS 10K).  The UPAS 10K, in turn, connects to a PC over a Hi-Speed 
USB cable. The PC functions as the host controller for the SASTracer and 
UPAS.  

SAS/SATA Analyzer can be controlled by either SASTracer software 
(which allows the capture of both SAS and SATA traffic) or SATracer 
(which allows only the capture of SATA traffic.)

Both SASTracer and SATracer software run on a Windows-based PC that 
serves as the analyzer controller.  This controller (or "host" as it is generally 
called) controls and configures the analyzer and retrieves and displays trace 
data. 

Recorded data is presented as a "trace" in the trace viewer as rows of 
color-coded graphics. Users can then search this trace for errors and other  
events using advanced search utilities, and then hide from the display all but 
only the most interesting and relevant data. 

The SATracer/Trainer trace viewing software runs on any personal 
computer using the Window 2000 or Windows XP operating systems and 
equipped with a functional USB interface. 
2



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
The SATracer is capable of on-the-fly detection of and triggering on such 
events as Primitives, Bus Conditions, Data Patterns, and Errors. Whether 
recording manually or with a specified trigger condition, SATracer 
continuously records the link data in a wrap-around fashion until manually 
stopped or until the Trigger Event is detected and a specified post-Trigger 
amount of link data is recorded.

Upon detection of a triggering event, the analyzer continues to record data 
up to a point specified by the user. Real-time detection of events can be 
individually enabled or disabled to allow triggering on events as they 
happen. This includes predefined exception or error conditions and a 
user-defined set of trigger events. 

The SATracer/Trainer software provides powerful search functions that 
enable investigation and highlighting of specific events. In addition to 
immediate analysis, you can print any part of the data. Use the Save As 
feature to save the data on disk for later viewing. The program also provides 
a variety of timing information and data analysis reports.
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1.2  Features 
• Separate Analyzer and Generator Modules that can be integrated into a 

single system
• Available with One, Two or Four 1.5 or 3.0 Gbps SATA analysis ports
• Supports Serial ATA Recording at 1.5 or 3.0 Gbps
• Sophisticated Triggering
• Hardware Filtering
• DWORD Display
• 4-lane (SFF-8484) External InFininband Style Connector Option
• Exerciser offers Host and Target Emulation
• Exerciser automatically responds to incoming OOB
• Traffic Summaries
• Collapsible / Expandable Headers
• Automatic Decoding of SATA FIS and ATA Command Layers
• Field Upgradeable BusEngine Technology
• Dynamically Allocated Memory Pool (2 GB)
• 3 Year Hardware Warranty
• All-in-one platform transmits, records, and analyzes the SATA protocol
• Monitor, trigger and record up to 4 Serial Attached SATA links 

simultaneously
• Isolate areas of interest with real-time hardware triggering
• Extend capture window by removing non-essential primitives 
• Chronologically display all DWORDs on all channels synchronized to a 

common clock 
• Flexible platform for testing host and end-device behavior
• Automatically bring SATA device under test through power up / reset 

and speed negotiation sequence
• Statistical reports provide high level abstraction of events and commands
• Easy “drill-down” on field structures for individual Frames, Commands 

and Tasks
• Easily upgrade firmware to support new features
• Protect your investment with industry-leading warranty
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SAS/SATA Analyzer and Exerciser BusEngine 
LeCroy’s BusEngine™ Technology is at the heart of the Analyzer and 
Exerciser systems. The revolutionary BusEngine core uses FPGA 
technology and incorporates both the real-time recording engine and the 
configurable building blocks that implement data/state/error detection, 
triggering, external signal monitoring, and event counting and sequencing. 
Like the flash-memory-based firmware that controls its operation, all 
BusEngine logic is fully field upgradeable, using configuration files that can 
be downloaded from the LeCroy Website. 

Power Cord Set
Cord Manufacturer and Models:

180-0005-00 Quail 5000.079 UL,CSA

180-0013-00 Quail 8500.098 VDE, KEMA, CEBERC, NEMDO, DEMDO, SETI,
OVE, SEV 

180-0014-00 Quail 9650.098 ASTA

SASTracer/Trainer on the UPAS 10000 Platform
CATC 10K chassis includes a USB 2.0 Certified Hi-Speed Device.  To 
upload traces from the UPAS/SASTracer to an attached PC at Hi-Speed, the 
PC must have a USB 2.0 Certified Host Controller and be running Windows 
2000 SP3 or Windows XP.

Note The CATC 10K products includes 2.0 USB hubs. You might see 
the drivers for these generic hubs being installed upon the initial 
plug-in.
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2.  Installation
SATracer is an application that works in conjunction with the SAS/SATA 
Analyzer module.  The SAS/SATA Analyzer module is sold as part of the 
Universal Protocol Analyzer System 10K (UPAS 10K).  

This chapter describes how to set up SATracer and create your first 
recording.

2.1  System Components/Packing List
• One stand-alone SAS/SATA Analyzer module
• One USB cable
• SATracer software program CD-ROM
• SATA(SAS) Cables
• Break-out board

Note: Specific components included with the SATracer/Trainer 3G 
system vary based on model and configuration ordered.

2.2  Analyzer PC Requirements
The analyzer connects to a Host PC over a USB cable.

Please consult the readme file on the installation CD for the latest PC 
requirements.

2.3  Analyzer Hardware Description
LeCroy’s  SAS/SATA Analyzer System is based on the CATC 10K chassis. 
Plug-in modules for SAS/SATA are available with either the Internal SATA 
style cable connector (SS002MAA-X & SS003MAA-X) or the new plug-in with 
External "Infiniband style" connectors  (SS004MAA-X) below.

Figure 1:    LeCroy Analyzer Systems

Module Part # SS002MAA-X & SS003MAA-X Module Part # SS004MAA-X 
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2.4  Analyzer LED Descriptions
When powered on, the SAS/SATA Analyzer activates the user-accessible 
controls and LEDs on the front and rear panels of the UPAS.

Warning Do not open the UPAS enclosure. There are no operator serviceable 
parts inside. Refer servicing to LeCroy.

Figure 2:  Front Panel (Internal single lane connector - SS002MAA & SS003MAA-X)

Figure 3:  Front Panel (4 Port External connector  - SS004MAA-X)

Front Panel LEDs (from left to right)

A PWR (power) - Green indicator LED for UPAS.  Lights when the unit 
power is switched on.

B Status indicator - Red indicator LED for UPAS.  Lights during 
initialization/power up of UPAS base unit. Blinks if a self-test fails.

C REC (recording) - Green LED. Lights when the unit is recording.
D TRG (triggered) - Orange LED.  Lights when the unit triggers on an 

event.
E UPLD (Upload) - Green LED.  Lights when trace is being uploaded from 

the analyzer to the PC.
F Manual Trigger - Push-button.  Allows a manual Trace capture.
G 1 - 4 (Link Channels 1 - 4) - Green LEDs.  Lights when a connection is 

established on the corresponding link.
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Connectors on the SAS/SATA Analyzer Module

• Plug-in Modules SS002MAA-X & SS003MAA-X  use single-lane Serial ATA 
Connectors (4).

• Plug-in Module SS004MAA-X  use 4 port Infiniband style connectors (1).

2.5  Rear Panel Description
From left to right, the UPAS rear panel contains the following components:

Figure 4:  Rear Panel 

USB type “B” host computer connector
This connector links the analyzer to the Host PC. for the purpose of 
transmitting commands from the PC to the analyzer and uploading traces 
from the analyzer’s recording memory to the SASTracer software for 
viewing and analysis.

RS-232 25 pin "Data Output" Connector
This connector links a 25 pin RS-232 cable to an external breakout board.  
The breakout board allows signals to be sent from the analyzer to an external 
device such as an oscilloscope or from an external device to the analyzer for 
the purpose of triggering on an external input.  You configure input/output 
signalling through the Recording Options dialog box.  Breakout board use 
is described at the end of this chapter.

BNC Connectors "Ext. In" and "Ext. Out"
These connectors allow BNC cables to be attached to the analyzer for the 
purpose of triggering on external input signals or for sending an output 
signal from the analyzer to another device.  These connectors have the same  
function as the 25 pin RS-232 connector - i.e., they channel input and output 
signals but do not support the use of a breakout board.  
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Wide range AC connector module
— Power socket

— Power on/off switch

— Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning For continued protection against fire, replace fuse only with the type 
and rating specified above.

2.6  Setting Up the Analyzer
Step 1 Remove the analyzer from its shipping container.  

The SAS/SATA Analyzer module will already be installed in the 
left slot of the UPAS.  The right slot may have a second analyzer or 
a SAS/SATA Exerciser.

Step 2 Connect the Analyzer unit to a 100-volt to 240-volt, 50 Hz to 60 Hz, 
120 W power outlet using the provided power cord. 

Note: The Analyzer is capable of supporting supply voltages between 
100-volt and 240-volt, 50 Hz or 60 Hz, thus supporting all 
known supply voltages around the world.

Step 3 Turn on the power switch on the rear of the UPAS.  

Note: At power-on, the analyzer initializes itself in approximately ten 
seconds and performs an exhaustive self-diagnostic that lasts 
about five seconds.  The Status LED of the UPAS base unit turns 
red on power up/initialization.  The LED remains on 
approximately 25 seconds while the analyzer performs 
self-diagnostic testing. If the diagnostics fail, the Status LED 
will blink red, indicating a hardware failure. If this occurs, call 
LeCroy Customer Support for assistance. 

Step 4 Insert the CD into the CD ROM drive of the PC that will be 
controlling the analyzer.

Step 5 Connect the USB cable between the USB port on the back of the 
analyzer and a USB port on the PC.
The operating system detects the analyzer and begins to install the USB driver.

Step 6 Follow Windows on-screen Plug-and-Play instructions for the 
automatic installation of the analyzer as a USB device on the Host 
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PC (the required USB files are included on the SASTracer CD). 
Step through the Windows hardware wizard.  The wizard will see 
that the UPAS has an internal USB hub and will begin loading hub 
drivers. Afterwards, the wizard will automatically install 
SATracer/Trainer as a USB device on the PC.  When the wizard 
prompts you for driver information, point it to the CD which should 
be in your disk drive and install catcupa.sys and SASTracer.sys.

2.7  Connecting Devices to the Analyzer
Model SS004MAA-X incorporates the SAS external "Infiniband style" 
connector which includes both a non-intrusive as well as a repeater style 
front-end.  This allows users to selectively switch between these two 
probing techniques based on their specific application. Only one pair of 
connectors may be used at a time.

Note: User’s with model SS004MAA-X must switch  between 
"repeater" and "non-intrusive" using the SASTracer software.  
Go to Setup > Probe Control to enable "repeater" or 
"non-intrusive" mode.  

Figure 5:  Plug-in Module SS004MAA-X offers two types of probing

Non-intrusive Tap
Also known as passive tapping, this approach silently samples the signal 
without re-driving the differential lines (high value resistors contribute to 
reduction in amplitude ˜ 15%).  
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Figure 6:  Non-intrusive tap diagram

Repeater Tap
In repeater mode, the analyzer reproduces the exact patterns it receives on 
the inbound (RX) line. While the repeater does not re-time the signal - it 
does "clean-up" normal reflections that can occur over a full length cable 
when the analyzer is not in the line.

Figure 7:   Repeater tap diagram

When using the External Connector Module (SS004MAA) to probe 
between devices that utilize single lane SATA connectors, the special 
octopus cable must be used. The SATA side of the octopus cables would be 
attached to the devices under test (see Figure 8).
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Figure 8:  Test Setup With DUT Requiring Single Lane SATA Connectors

Note: The initiator side must be a "cross-over" cable.

Figure 9:   Test Setup With DUT Requiring External 4 Lane Connector

Note: When using new External Connector Module (SS004MAA) 
with standard 4X External InfiniBand style cables, there is no 
need to use  "cross-over" cable. Both cables above are straight.
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LeCroy Analyzer with Internal SATA Connectors (SS002MAA & SS003MAA) 
When using original single-lane "SATA-style" module (SS002MAA & 
SS003MAA) with devices that utilize single-lane SATA style connectors, 
the special octopus cable must be used. The SATA connector side of the 
octopus cables would be attached to the analyzer (see Figure 10).

Figure 10:   Test Setup With DUT Requiring External 4 Lane Connector

Note: The target side must be a "cross-over" cable.

2.8  Installing the SATracer Software
Once SATracer has been recognized as a USB device, install the SATracer 
software on the Host PC.

Step 1 On the PC, run setup on the installation CD and follow the 
on-screen instructions.

The SATracer software will install on the PC hard disk.

Step 2 To start the application, launch the LeCroy SASTracer program 
from the Start menu:  
Start > Programs > LeCroy > SATracer.
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The SATracer program opens. 

Note: The software may be used with or without the analyzer.  When 
used without an analyzer, the program functions as a Trace 
Viewer to view, analyze, and print captured traffic. 

2.9  Making a Recording
After installation, the software is configured to make a four-Mbyte snapshot 
recording of your SATA traffic. 

To make this recording, follow these steps:

Step 1 Connect a cable to each of the two connectors on the SAS/SATA 
Analyzer module, then connect the other ends to the Serial ATA 
device under test and Serial ATA host system.

Step 2 From the Setup menu, select Recording Options.

Step 3 Select the General tab. 
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The following window displays the factory default settings such as 
“Snapshot” and 16 Mbytes buffer size are displayed. For your first 
recording, you can leave these settings unchanged.

Step 4 Click  on the Tool Bar. After 16 Mbyte of traffic is recorded, the 
SATracer/Trainer Analyzer uploads the data and displays the 
Frames.

Stopping a Recording
You can stop the recording process at any time by pressing .  
Afterwards, the trace will automatically upload from the analyzer to the PC.
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Interrupting the Upload Process
You can interrupt the upload process by pressing the Stop  button.  
Pressing Stop will cause the following dialog box to open: 

This dialog presents options for stopping, continuing, or aborting the 
recording:

• Select New Upload Range within the Recorded Buffer 

• Slide Bar - Adjust arrows at either end of the slide bar to 
select the range of buffer you want uploaded.  The color 
in the slide bar indicates pre- and post-trigger traffic.   

• Full Buffer - Uploads entire buffer to the PC.

• Upload Selection - Uploads whatever range you have 
selected via the slide bar.

• Abort Upload?

• Stop - Stops the recording and then displays the trace on 
screen.

• Continue - Resumes the recording.

• Flush - Cancels the recording without saving or 
displaying the trace.
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Once you have interrupted an upload, a new button will appear on the 
toolbar:  .  This button ("Re-upload") opens a dialog box with a slide bar 
for re-selecting the range of the trace that you would like to upload.  

Saving the Trace
When the recording session is finished, the bus traffic is uploaded to the PC 
and is automatically saved to the hard drive as a file named data.sata or the 
name you assign as the default filename. 

Step 1 To save a current recording for future reference, select 
Save As from the File menu.

Step 2 Give the recording a unique name and save it to the appropriate 
directory.

2.10  Probe Control Settings
The probe control dialog provides several user adjustable settings for the 
probe performance.  Modification of these settings occur in real-time and do 
not require cycling the power or uploading new firmware. 

If there’s more than one 
analyzer connected, the 
user will have an option to 
select Probe Control 
Settings for each device 
individually
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The Port Settings and OOB Idle Sensitivity are only available when the 
SAS/SATA analyzer system is operating in Repeater mode.  

The Plug-in Mode options provide an additional control for the External 
Connector Module (SS004MAA) only. These controls will be disabled 
when attached to the Internal SATA-style module (SS002MAA) because 
this module operates in Repeater mode only.

Break Link - Checking this box for a specific channel takes the link to 
electrical idle. It has the same effect as manually detaching a single 
connector from the device to "break the link". Unchecking the Break Link 
box for a specific channel brings the link up. It has the same effect as 
attaching a connector to a powered-on device. 

High Swing - Alters the repeaters differential output swing to accommodate 
for PCB / connector loss. By default, the repeater uses "Normal" swing. 
"High" swing may be required when tapping between long backplanes or 
extended cable distances: 

• Normal Swing: 440 mV min and 660 mV max  (peak to peak)

• High Swing:  800 mV min and 1200 mV max  (peak to peak)

OOB Idle Sensitivity - Alters the repeaters OOB detection behavior to 
accommodate for marginal OOB signal amplitude in SAS/SATA devices 
under test. The OOB idle sensitivity offers an adjustable threshold for 
detecting an inbound OOB sequence. If two PHYs fail to complete OOB, 
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users may find lowering the OOB idle sensitivity provides a mechanism for 
establishing the link even when the OOB signals from the DUT are 
marginal.

• Normal - 100mV to 200mV

• Decrease 30mV

• Decrease 60mV
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3.  Software Overview
The SATracer/Trainer is an application that may be used with or without 
hardware. When used without hardware, the program functions as a trace 
viewer to view, analyze, and print captured protocol traffic from other 
SATracer analyzers.  

3.1  Starting the SATracer/Trainer Program
To start the SATracer/Trainer Program from the Start menu,

Select Start > Programs > CATC > CATC SATracer. 

3.2  Opening Sample Traces
A good way to gain familiarity with SATracer is to open some of the 
provided sample files and explore the menus, pop-up menus, and reports. 

3.3  Tool Tips
Throughout the application, Tool Tips provide useful information about  
buttons on the toolbar.
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To display a Tool Tip, position the mouse pointer over 
an item of interest such as part of the trace or a button.  

3.4  Trace Tool-Tips
Many fields within the Trace will display tool-tips when the mouse pointer 
is suspended over them.  These tips may provide a simple legend for the cell 
or may give substantial added details about the field. 

3.5  The Menu bar
While some of the analyzer’s main display window options are familiar, 
many contain options specific to the analyzer program.

Table 1: Main Display Pull-Down Menus
Menu Function

File
New GenFile Creates a new (and empty) traffic generation file.  To add text, click the 

Edit as Text button on the toolbar.
Open… Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As… Saves all or a specified range of Frames from the current file with a 

specified name.
Print… Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing.
Print Setup… Sets up your current or new printer.
Edit Comment… Opens a dialog for entering a brief comment about the trace.
Export>> Packets to Text (Packet View Format) - Saves all or part of a Trace 

to a text file.  Useful for saving traces to floppy disk and for e-mailing.  

to Generator File Format ... -  Creates a traffic generation file based 
on the open trace.  This is a fast and easy way of creating a traffic 
generation file.

to Packets to EAS Format ... - Creates an EAS file based on the open 
trace.  Running this command opens a dialog prompting you for a file 
name, path, and a range of Frames to be exported.

Convert>> Convert .stg to .ssg - Converts  SATA traffic generation files created 
by SATracer (.stg) to the SASTracer generation format (.ssg).

Exit Exits the SATracer/Trainer program.
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Setup
Display Options… Opens a dialog for customizing trace colors, formats, and filters.
Recording 
Options…

Configures the analyzer’s recording behavior.  Opens a dialog for 
selecting event triggers and filters, and for setting the size of the 
recording buffer and other recording options.

Update BE/FW… Opens a dialog for updating the BusEngine and Firmware.
Channel Settings Allows renaming of the channels - i.e. the establishment of aliases for 

each channel.
Analyzer Network ... Opens a dialog box for browsing to local and networked analyzers.  

Within the dialog, click Add to browse.  The dialog lists PCs that are 
on the LAN.  If a PC has an analyzer attached to it, clicking Select 
establishes a connection. 

All Connected 
Devices ...

Opens a dialog box with a list of analyzers connected to the host PC.  
Lets you select an analyzer and update the BusEngine, Firmware, and 
licensing information.

Record
Start Causes the Analyzer to begin recording.
Stop Causes the Analyzer to stop recording.

Generate
Start Generation Starts traffic generation.  This command requires that a traffic 

generation file (.ssg) be open.
Stop Generation Stops traffic generation.
Resume Generation Resumes traffic generation if generation has been stopped.
Connect Link Establishes a link between SATrainer and the DUT.
Disconnect Link Breaks the link between SATrainer and the DUT.
Generation Options Opens a dialog for configuring traffic generation.  The dialog looks like 

the Recording Rules dialog (Setup > Recording Options > Recording 
Rules).  See Generation Options in the Traffic Generation chapter.   

Report
File Information Displays information about the recording such as the number of Frames 

and triggering setup.
Error Summary Summarizes the errors throughout the recording. Allows for fast 

navigation to errors.
Timing Calculations Calculates timing between two Frames.
Traffic Summary Summarizes the numbers and types of  Primitives, Frames, SCSI 

Operations, and errors that occurred in the open Trace.
Bus Utilization Displays graphs of various types of events that occurred in the open 

trace.
Link Tracker » Opens a window for displaying a detailed chronological view of Bus 

activity on a Primitive-by-Primitive basis.  
Frame Tracker Opens a window for displaying a detailed chronological view of traffic 

on a Frame-by-Frame basis.

Menu Function
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Search
Go to Trigger Positions the display to show the Trigger event.
Go to Event... Positions the display to the indicated Packet, Frame, Primitive etc. The 

menu is context-sensitive and depends on the decode level that you are 
currently displaying.

Go to Marker » Positions the display to the selected marked Frame.
Go to » Enables quick searching for specific events using a cascade of pop-up 

windows.
Find ... Allows searches by multiple criteria.
Find Next Looks for the next instance of an event specified with Goto or Find.
Search Direction Allows the search direction to be changed from forward to backwards 

or backwards to forward.  

View

Toolbars Displays list of available Tool bars.
Analyzer Chat Bar Opens a dialog that allows users to conduct chat sessions over an IP 

LAN.  In order to send and receive electronic text messages, each user 
must be working with a PC that is on an IP LAN and also attached to an 
analyzer.  .

Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed Frames within the window.
Link Layer Displays Link Layer traffic in the trace. 
Frame Layer Decodes and displays the Frame Layer.
FIS Layer Decodes and displays FIS layer transactions.
Command (ATA) 
Layer

Decodes and displays ATA Application layer.

Window

New Window Switches display of the Tool bar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Displays all open windows as a series of strips across the display.
Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help

Help Topics ... Opens online help.
Update License ... Opens a dialog box for entering license key information for the 

analyzer.
Display License 
Information ...

Opens a dialog box with information about the current status of the 
analyzer's license

About ... Displays version information about SATracer/Trainer.

Menu Function
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3.6  The Toolbar 

The Tool Bar provides quick access to most of the SATracer/Trainer 
software functions. You can learn the function of each button by passing the 
mouse pointer over them.  Descriptions of the buttons appear on the status 
bar at the bottom of the window and as tooltips above each button. 

Open file Stop Recording

Save As

Re-upload.  This button appears in the 
toolbar if Stop is pressed during an 
upload.  Causes analyzer to re-upload 
trace from  analyzer buffer to the PC.  
Gives options for selecting which part of 
the trace you want uploaded.

Preview Zoom In

Print… Zoom Out

Edit as text - opens a text editor for 
editing traffic generation files. Wrap

Setup Record Options

Find - Opens a dialog for conducting 
complex searches

Setup Display Options

Find Next - repeats last Find or Go To 
operation

Start Recording

Trace Panes.  Allows multiple traces to be 
locked together and scrolled in tandem.  
This option only works with .mlt traces 
created by multi-analyzer cascades in a 
single recording session.
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Reports Buttons 

Decode Buttons 

Hide Buttons 

Multi-segment Trace File Buttons
These buttons become active if a multi-segmented trace file has been 
opened.  Multi-segment traces are traces that have been recorded as a series 
of small segments rather than as a single, large recording.  Multi-segmenting 
was developed to make it easier to work with large recordings where 
navigation can sometimes be difficult. 

Multi-segmenting is enabled in the General page of the Recording Options 
dialog.

Multi-segmenting produces two kinds of files:  segments and an index file 
that summarizes the recording and keeps tabs of the various segments.

File Information Report.  Opens a 
summary of the trace file including when 
it was made, the Recording Options used 
to create the file, and data on the analyzer 
that recorded the trace.

Traffic Summary.  Opens a window 
displaying a table summary of traffic 
recorded in the trace.

Error Report.  Opens the Traffic 
Summary window and displays a 
summary of errors in the trace.

Bus Utilization.  Presents a graphical 
summary of traffic in the trace.

Timing and Bus Usage Calculations.  
Opens a calculator for measuring timing 
between Frames.

Show Link Tracker.  Opens window with 
detailed chronological view of traffic on a 
Primitive-by-Primitive basis.

Show Data Block.  Opens a dialog for 
navigating to data blocks within Frames 
and Transactions.  Once a data block is 
located, the window can display the data 
in a variety of formats. 

Show Frame Tracker.  Opens window 
with detailed chronological view of traffic 
on a Frame-by-Frame basis.

Open Auditor.  Opens window that 
summarizes the trace in a spreadsheet-like 
format.

Decode & display Link Layer (Frames & 
Primitives)

Decode & display ATA Application layer 
(ATA commands)

Decode & display  FIS Layer 

Hide Align and Notify Primitives Hide Initiator Channel 1

Hide SATA Sync Cont Primitives Hide Target Channel 1

Hide Unassociated traffic
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The buttons below allow multi-segmented traces to be navigated. 

Traffic Generation Buttons
These buttons become active if a traffic generation file (.ssg) is open.

3.7  Pop-Up Menus
Pop-up menus within the trace provide options for formatting the trace. 

Left Mouse Button - Opens a menu for expanding fields, viewing data 
fields, and formatting the trace.  

The menu is context-sensitive and changes depending on what part of the 
trace has been clicked. 

A menu similar to the following appears:

• Data Field - Indicates the type of field that you selected.  This 
field is context-sensitive.

Show first multisegment file Show next multisegment file

Show previous multisegment file Show last multisegment file

Show multisegment index file

Start Traffic Generation. This button 
activates if a traffic generation file (.ssg) 
is open and an SATrainer is attached.

Connect link.  Establishes a link between  
SATrainer and the DUT.  When a 
Connect is built into the traffic generation 
script, this button will give status on the 
connection (it will depress when a connect 
occurs and undepress when disconnected.)

Stop Traffic Generation. This button 
becomes active if a traffic generation is 
underway.

Disconnect link

Resume Traffic Generation.  Generation Options.  Opens a dialog for 
configuring traffic generation.
 27



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
• View Data Block - Allows raw data to be viewed from a data cell. 

• Expand Data/Collapse Data - Expands or collapses data field. 
Summarizes the amount of data displayed in the cell. 

• Expand All Data Fields - Expands any data fields that are 
currently collapsed. 

• Collapse All Data Fields - Collapses any data fields that are 
currently expanded. 

• Format - Presents options for changing the numerical formatting 
of the data fields throughout the trace.

• Color - Presents options for changing the color of the data fields 
throughout the trace.

• Hide - Hides data fields throughout the trace.  To re-display 
hidden fields, right-click anywhere in the trace and select Unhide 
Cells and then one of the options from the sub-menu.

Right Mouse Button - If you click a cell in the trace with 
the right mouse button, a pop-up menu appears and 
shows the options for zooming in or out, wrapping the 
display, and other formatting options.

3.8  Status Bar
The Status Bar is located at the bottom of the main display window. 
Depending on the current activity, the bar can be divided into as many as 
four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays 
a recording Progress Indicator:  

As recording progresses, the Progress Indicator changes to reflect the 
recording progress graphically:

• In the Progress Indicator, a black vertical line illustrates the 
location of the Trigger position you selected in Recording Options. 
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— Pre-Trigger progress is displayed in the field to the left of the 
Trigger Position. 

— When the Trigger position is reached, the progress indicator 
wiggles as it waits for the Trigger. 

— After the Trigger occurs, the field to the right of the Trigger  
fills in the post-Trigger color specified in the Display Options. 

— When recording is complete, the upper half of the progress 
indicator fills in white, indicating the progress of the data 
upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate 
that not all the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger event, the Progress 
Bar adjusts  to begin uploading the most recently recorded data.

• If you wish to abort an upload that is in progress, click the Stop 
button again.

The Progress Bar fills with color in proportion to the specified size and 
actual rate at which the hardware is writing and reading the recording 
memory. However, the progress indicator is normalized to fill the space 
within the Status Bar.

Recording Status
During recording, the current recording status is displayed in the next 
segment of the status bar. (Refer to previous screenshot for examples.)  
When recording is begun, one of the following messages flashes (depending 
on the selected Recording Options):

• Trigger?
• Triggered!
• Uploading

After recording stops, The following occurs:

• Flashing message changes to Uploading data–x% done (x% 
indicates the percentage completion of the data uploading process). 

• Traffic data is copied to disk (overwriting any previous version of 
this file) using the default file name data.sata. You can also create 
a file name of your choice by specifying one in the Recording 
Options window.

To abort the upload process, press the Stop button.
 29



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display 
window, and the Recording Status window is cleared. 

• If the recording resulted from a Trigger event, the first Frame 
following the Trigger (or the Frame that caused the Trigger) is 
initially positioned second from the top of the display.

• If the recording did not result from a Trigger event, the display 
begins with the first Frame in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays 
Recording activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity 
being recorded.  If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Search Status
The rightmost segment displays the current search direction: Fwd (forward) 
or Bwd (backward).  

3.9  Navigation Tools
You can zoom in and out, and wrap the trace to fit within the screen by using 
the following buttons:

Zoom In
Increases the size of the displayed elements, allowing fewer (but larger) 
Frame fields per screen. 

Click  on the Tool Bar.

Zoom Out
Decreases the size of the displayed elements, allowing more (but smaller) 
Frame fields per screen. 

Click  on the Tool Bar.

Wrap
Adjusts the Trace View so that Frames fit onto the next line if they are 
longer than the size of the window. Without Wrap, you can use the 
horizontal scroll bar to see the hidden part of a Frame.
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Click  on the Tool Bar.  

3.10  Adding Comments to the Trace
You can create, view, or edit the 100-character comment field associated 
with each Trace file.

Step 1 From the File menu, select Edit Comment.

The Edit Trace Comment Dialog window appears.

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

3.11  Set Marker
The Set Marker feature allows Frames to be marked so they can be 
navigate back to events of interest.  Markers also provide you with a way of 
tagging events so you can perform timing calculations between them.

The Set Marker command works in conjunction with the Go to Marker 
feature.  Once you have marked a Frame, you can navigate back to it by 
selecting Search > Go to Marker, and then selecting the marker of interest 
from the list.

Trace with Wrap turned off.  In this example, the Time Stamp extends

Trace with Wrap turned on.  Entire Frame displays in window.

off the right edge of the screen.
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To set a marker on a Frame, perform the following steps: 

Step 1 Click on Frame # for the Frame you wish to mark.

Step 2 Select Set Marker.

The Edit Market for Frame # comment window appears.

Step 3 Enter your comment. 

Step 4 Click OK.

A marked Frame is indicated by a vertical red bar along the left 
edge of the Frame # block: 
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3.12  Edit or Clear Marker
To clear or edit comments associated with a Frame marker, 

Step 1 Click on Frame # for the chosen packet.

Step 2 To edit the marker comment, select Edit Marker.

The Edit Marker for Frame # comment window appears.

Step 3 Edit the comment as desired.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker.

The vertical red Marker bar disappears.
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3.13  Timing Calculations on Markers
Markers can be used as reference points to calculate timing between events.  
To perform a timing calculation, select Reports > Timing Calculations, 
and then click the Markers buttons to select the markers you want to use for 
the calculation. Afterwards, click Calculate to calculate the timing between 
the marked events. 

You can also calculate timing between markers by clicking the left mouse 
button on the first cell of a Frame in the trace window and selecting Time 
from Marker from the pop-up menu.  The Timing Calculations dialog will 
open and prompt you to select a marker.  Upon selecting a marker from the 
list, the calculation will be performed.
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4.  Recording Options
The Recording Options dialog box presents options for configuring a 
recording.  The dialog box has four pages of options:  General, Channel 
Settings, Recording Rules, and Channels.  

From the Setup menu, select Recording Options.

Recording Options window appears, displaying the General tab.
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4.1  General Recording Options
The General page presents options for setting the buffer size, recording type, 
and the Trace filename and path.

Two sets of Recording Type options are presented:  Recording Scope and 
Recording Type.

Recording Type
The Recording Type box presents three options that control how 
SATracer/Trainer begins and ends a recording. The options are Snapshot, 
Manual Trigger, and Event Trigger.

• Snapshot: A Fixed-length recording.  A Snapshot is a recording 
whose size is set via the "Buffer Size" box. Recording begins when 
the Start Recording button   is clicked and ends when either the 
selected buffer size is filled or the Stop Recording button  is 
pressed. 

• Manual Trigger: A recording whose ending is triggered by 
pressing the Trigger button on the front panel.

Recording begins when the Record button  is pressed  on the 
Tool Bar. Recording continues in a circular manner within the 
limits set by the buffer size. Recording ends following depression 
of the Trigger button on the front panel.  Once the Trigger button 
has been pressed, recording continues until the post-trigger buffer 
has been filled or the Stop button   is clicked on the Tool Bar.

• Event Trigger: A recording whose ending is triggered by 
user-defined events. Recording begins when the Record button  

 is clicked on the Tool Bar.  Recording continues in a circular 
manner within the limits set by the buffer size until a trigger event 
is detected and the defined amount of data has been recorded after 
the Trigger event.

Options
The options checkboxes appear on the upper right side of the General tab of 
the Recording Options window. 

• Truncate Data Payload Dwords:  Allows data payloads to be 
truncated to whatever length is specified in the box.  Truncating the 
payload preserves recording buffer, thereby increasing the amount 
of traffic that can be recorded.
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• Beep When Trigger Occurs: When this checkbox is selected, the 
computer connected to the SATracer/Trainer beeps three times 
when a Trigger condition is first detected.

Recording Scope
Recording Scope presents two important options that affect the size or scope 
of the recording.  These options are Spooled and Conventional recordings.  
The Spooled option enables very large recordings - for example, several 
hours.  The Conventional option is used for smaller recordings - for 
example, several minutes.

Conventional Single Buffer Recording
In a Conventional recording, the entire trace is recorded and stored in the 
analyzer buffer before it is uploaded to the host PC.  Recordings are thus 
limited in size to the size of the analyzer buffer - or 2 GB.  If you are 
planning to create a moderate-sized recording, this is a good option to select.   
You set the buffer size and the trigger position, then begin the recording.  
The analyzer’s buffer fills, then the traffic is uploaded to the host PC.

If you are planning to create a large recording or are planning to let the 
analyzer run over a several days, then select Spooled Recording.  In a 
Spooled Recording, traffic is uploaded periodically to the host PC - thus 
freeing analyzer buffer and allowing the recording to continue.

Buffer Size - The Buffer Size slide bar adjusts 
the recording buffer size from 1.6 megabytes to 
2048 MB.    This option is used for setting the 
memory for a Conventional recording.

The Recording Type option determines how 
this buffer is used. Although there are 2048 MB of physical memory in the 
Analyzer, the efficiency of the recording ranges from 2:1 to 4:1 ratios of 
physical memory to actual SATA traffic. Shorter Frames yield a less 
efficient recording. The non-traffic portion of physical memory is utilized 
for control and timing information.

Note The scale is not linear and affords more granularity in the smaller 
buffer sizes. 

Trigger Position - The Trigger Position 
slide bar sets the amount of pre- and 
post-trigger recording in a Conventional 
recording. It also allows adjustment of the 
location of the trigger within the defined 
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buffer. You can adjust the Triggering Position between 1 and 99% 
post-Trigger. Trigger Position is available only when Manual Trigger or 
Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note When a Trigger occurs, recording continues until the post-Trigger 
amount of the buffer is filled.

Note The buffer is limited to 1 GB when in trainer mode/configuration.

Save As Multisegment Trace 
This option causes the 
analyzer to segment the 
trace into multiple files and  create an index file called data.mlt that 
summarizes the starting and finishing frame for each segment. 

This option is useful for very large recordings and for host PCs with limited 
memory.  In the latter case, multi-segmenting gives a PC with limited 
memory a way to open recordings that would otherwise be too large to open. 

The only downside to multi-segmenting is that limits the scope of reports 
such as Traffic Summary, Bus Utilization, and Error Summary to each of 
the segments.  You will not be able to perform summary statistics on the full 
recording.

The default value for this option is 64 MB.  Before attempting large 
recordings, it is recommended that you play with this number to see what 
value best suits your needs.  

To create a multisegmented trace,

Step 1 Check the box marked  Save As Multisegmented Trace.

Step 2 Set the file size for each segment in the box marked MB Segments.  
38



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
File Structure for Segmented Files
Multisegmenting produces an index file and segmented trace files.  The 
default name of the index file is dataXYZ.smt, where XYZ is the last three 
digits of the analyzer’s serial number.  (You can see the unit’s serial number 
by selecting Help > About SATracer.)  Thus, for example, if you had an 
analyzer with the serial number 111, the index file would be called 
data111.smt.

The index file and the segmented trace files are stored in a directory named 
after the index file.  The directory is named indexfilename_smt_files.   For 
example, if the index file is named data111.smt, the directory will be named 
data111_smt_files.  Below this directory additional, sequentially numbered 
sub-directories (up to 100,000) that house the segmented trace files.  These 
sub-directories bear simple numerical names: 00000 - 00999.  Each of these 
subdirectories can hold up to 100 sequentially-numbered segment files.  
Collectively, the entire directory structure can hold up to 10 million files.

Example

A 1010 MB recording using 10 MB segments and the default file names will 
create the following sub-directories and files.  The example below uses the 
serial number 111:

• data111.smt   This is the index file.  
• data111_smt_files\00000\segment_00000.sata
• data111_smt_files\00000\segment_00001.sata

...

• data111_smt_files\00000\segment_00099.sata
• data111_smt_files\00001\segment_00100.sata
• data111_smt_files\00001\segment_00101.sata

The index file looks something like a trace file but contains packet-like 
entities that summarize each 10 MB segment.  
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When uploading is complete, the index file will be opened.  Each "packet" 
in this file corresponds to one of the numbered segments.  Double clicking 
on the packet will open the corresponding segment file.

Multisegement Toolbar 
When an index file is opened like the one shown above, 
the Multisegment Toolbar will display.  This toolbar lets you navigate the 
index file.  

Spooled Recording
In a Spooled recording, uploading commences when the recording is begun.  
As traffic is uploaded from the analyzer to the host PC, the analyzer memory 
is freed - creating space for recording additional traffic. Recording can thus 
continue for long periods of time, and create file lengths well in excess of 2 
GBs.

Recording Size
With Spooled Recordings, you are given the option of setting the recording 
length based on time or on the recording size.

Record for - Enter the duration of the recording  in days, hours, minutes, 
and seconds.

Record - Enter the amount of traffic (in MB) that you want the analyzer to 
record.  Selecting this option will create a fixed length recording that begins 
as soon as you click the REC button on the menu bar.

Until Triggered, plus - Enter the amount of traffic (in time) that you want 
the analyzer to record following an event trigger.  Recording time units are 
days, hours, minutes, and seconds.

Open first segment in 
multisegment trace.

Open previous segment 
in multisegment trace.

Open index file.  This 
button becomes active if 
a multisegment trace file 
is open. 

Open next segment in 
multisegment trace.

Open last segment in 
multisegment trace.
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 Until Triggered, plus  -  Enter the amount of traffic (in MB) that you want 
the analyzer to record following an event trigger.  You select event triggers 
in the Recording Rules page -- see Section 4.3, “Recording Rules” on 
page 43 for details.

Spooled Recordings - Performance Issues
During a spooled recording if the analyzer buffer fills faster than the trace 
can be uploaded to the host PC, the analyzer will briefly suspend recording  
until some of the buffer is free.  When recording is suspended, gaps will 
appear in the trace.  These gaps will appear as entries in the trace.  

During the recording, you can see if gaps are likely to happen by reading the 
status bar at the bottom of the screen.  

The Status bar has two fields that you can use to determine if gaps are 
occurring or are about to occur.  These fields are:

• gaps - Shows how many gaps have occurred. 

• Hardware Buffer - shows you how full the analyzer buffer is and 
if the analyzer is currently dropping packets.  In the example 
above, Hardware Buffer field shows that the buffer is full (shown 
by the thick green graph) and that the analyzer is currently 
dropping packets (shown by thin red line atop of the green graph.)  

Preventing Gaps
Gaps can be caused by a number of factors - the number of channels being 
recorded, the absence of filtering, the performance of the host PC (for 
example, is it using USB 2.0 to upload traffic?), and the amount of traffic 
produced by the devices under test.

There are several ways to prevent gaps.  You will need to experiment with 
your setup to determine what works best for you.  You might try filtering 
out Aligns and Syncs and turning on data truncation (for example, to 10 
Dwords).
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4.2  Channel Settings
The Channel Settings page lets you to set speed, descrambling, and packing 
options for each channel.  It also lets you inhibit channel recording.

Speed Settings
Speed Settings provides options for designating the recording speed for 
each link. You can manually set the link speed or let the analyzer 
auto-negotiate the speed.

The SATracer system is designed to pass through the speed negotiation 
signaling allowing the initiator and device to determine the link speed using 
the method defined in the SATA specification. However, if the negotiated 
link speed is higher or lower than the speed selected in this tab, SATracer 
will not decode the traffic properly (there will be errors in the trace). If an 
initiator and target are successfully negotiating 3Gbps transmission rate, 
choose the 3Gbps Speed Selection in this tab. The user will know if devices 
are negotiating successfully by getting clean recordings.

Channel Settings
These options allow you to inhibit recording and turn off scrambling and 
packing on a channel by channel basis.
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Inhibit - Inhibits recording of traffic from selected channels.  For example, 
if you check the option for T1, it means "record all channels except for 
Target channel 1 (T1)."

No Descrambling - Turns off the analyzer’s descrambling from the selected 
channels.  Select this option if your DUTs are not scrambling their traffic.

No Packing -  Turns off primitive and idle packing from the selected 
channels. 

4.3  Recording Rules
The Recording Rules page lets you set triggers and filters. The page divides 
into following areas:  

• Toolbar - Contains buttons that control the Recording Rules page.  
• Available Events area -- Part of the screen where you can park 

buttons that you intend to use in the Global State Cell.
• Global State Cell -- Part of the screen where you create trigger and 

filter conditions. You create conditions by dragging event buttons 
from the Available Events Area into the Global State Cell and then 
assign actions to the event buttons.  

• Sequence Cell -- The inactive cell marked by the faint text Drag an 
event here to add a new sequence.  Once an event button is placed 
in this cell, the cell becomes active.  The Sequence Cell is used to 
create event sequences - chains of events leading to an action:  If x 
followed by y followed by z occurs, trigger.  Event Sequences are 
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created by assigning the action Advance the Sequence to the links in 
the chain and trigger (or some other action) to the final event.

• Rule Status Indicator - An indicator that shows the validity status 
of the current set of recording rules.  When the rules are correct, the 
indicator will display the text Config is valid.  When incorrect, the 
indicator will turn red and display the text Config is Invalid.

• Pop Up Menus (not shown) - Right-clicking on button or area in 
the Recording Rules page will access a context-sensitive pop-up 
menu containing most of the commands listed in the toolbar.

4.4  Recording Rules Toolbar
The Recording Rules toolbar exposes functionality for controlling the 
Recording Rules page.  

New Event.  Opens a menu of events.  Selecting an event 
causes an event button to appear in the Available Events area.  

Delete Event.  Deletes selected event button.

Undo.  Undoes last change made to Recording Rules page.  
The undo buffer has unlimited depth.

Redo.  Repeats changes undone by the Undo button.

Zoom In.  Enlarges the display.  There are five zoom levels.  
The default level is the middle one.  If you have a wheel 
mouse, you can also zoom by holding down the Control key 
and then operating the mouse wheel.

Zoom Out.  Makes the display appear smaller.  

Show/Hide channels.  When pressed, this button tells the 
Recording Rules dialog to show the channel buttons on the 
Events icons.  When unpressed, the channels are hidden.  

Show/Hide Properties Dialog.  Shows or hides the Properties 
dialog of the selected State/Event/Action.

Config is valid.  This message displays when the current 
Recording Rules configuration is valid and can be executed by 
the hardware.  This message gets updated every time the 
Recording Rules configuration changes.  When the 
configuration is incorrect, the message is replaced by "Config 
is incorrect."

Config is invalid.  This message displays when the current 
Recording Rules configuration exceeds hardware limitations.  
You can click the indicator to get the diagnostics message box 
to find the problem.
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4.5  Recording Rules Page - How it Works
The Recording Rules page can be thought of as a chalk board where you  
create a graphical model of the events and actions.  In essence, you are 
creating a visual representation of the rules that the analyzer should follow 
during a recording.

You can create simple or complex rules.

Creating a rule involves three steps: 

Step 1 Select one or more events.

Step 2 Select the channels that the analyzer should record.  

Step 3 Assign an actions to the events. 

Selecting Events 
Events are selected from the New Event menu:

Step 1 Click the New Event button. 

A menu of Events and Event categories 
displays.

Step 2 Select an Event from the menu.  Once a 
selection has been made, an Event button 
appears in the Available Events area. The 
Available Events area is an inactive part of the 
window where buttons can be parked for future 
use. 

Selecting a Channel on an Event Button
At the bottom of each event button are small buttons that represent  analyzer 
channels.  Selecting a channel button tells the analyzer which channels to 
monitor for trigger and filter events.  

Note that deselecting a channel button does not stop the 
recording on that channel - it  merely disables actions 
such as triggers on the channel.  Thus, if you had set the 
analyzer to trigger on an error but had deselected channel 
T1, the analyzer would record traffic on all channels (including T1) but 
would ignore any error that occurred on channel T1.

To turn off recording for individual channels, use Inhibit Recording option 
in the Recording Options > Channel Settings page.  This option will prevent 
traffic from being recorded into the trace.  
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4.6  Assigning an Action
Assigning an action tells the analyzer what to do when it has found the 
targeted event.  If you do not assign an action, the analyzer will look for the 
event but do nothing once the event has been encountered.

Assigning an action is a two-step process:  first, move an Event button from 
the Available Events area on the left to one of the two cells in the center of 
the window.  Then, right-click on the Event button and assign an action.

Dragging a Button to the Global State or Sequence Cell
The center of the Recording 
Rules window is where rules 
are defined.  To create a rule, 
you must drag an Event button 
from the Available Events 
area on the left to one of the 
two cells in the center of the Recording Rules window.  The cells in the 
center control the duration of the rule:  rules created with the Global State 
Cell are always enabled, while rules created in the Sequence cell are 
conditionally enabled.

The Global State Cell - The Global State 
Cell tells the analyzer what events to look for 
throughout the entire recording.  The cell is 
called a "Global State" because the 
conditions you define in the cell are always 
active.  You can place several events in this 
cell.  Doing so tells the analyzer to look for 
all of the events all of the time.   For example, 
you could place three events in this cell and 
have each cause a trigger.  Such a 
configuration would read "If any of the events occur, trigger."

Sequence Cell - Sequence cells are marked with the faint text Drag to add 
a new sequence.

The Sequence Cell is used to 
create event sequences.  An 
event sequence is a chain of 
events leading to some action.   
For example, "If x is followed 
by y and then by z, trigger."  
Events linked in a chain are 

To activate an Event button, drag it to the 
Global State Cell.

This configuration reads
"trigger if any of these events
occur."

An event sequence.  This reads "If a primitive 
is followed by an error, then trigger."
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looked at sequentially.  Thus, at any given time, the analyzer is often only 
be looking for a single event out of the several that might be in the Sequence 
cell.  

There can be up to 255 events linked together into a sequence.  Only one 
sequence can be created.

When two or more events have been moved into a Sequence cell, they can 
be linked into a sequence by assigning the action Advance the sequence to 
events in the chain.  The last event in a sequence is then usually assigned the 
action Trigger.  

There are two ways to assign an action to an event button:

• Right-click on an event button and select Specify Action from 
the pop-up menu.

• Double-click on the event button and then select an action from 
the Properties dialog box.

Assigning an Action from the Pop-up Menu
To assign an action to an event button via the pop-up menu,

Step 1 Right-click on the button.  A pop-up menu appears:  

Step 2 Select Specify Action and then an action from the sub-menu.  The 
menu closes and the action is assigned.  
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Assigning an Action via the Properties Dialog Box
Step 1 You can also assign actions to event buttons via the 

Properties dialog box.  Double-click on an event button to 
open the properties dialog box.  

Step 2 Select the Actions tab.  

Step 3 Assign an action.

See See Section 4.9 "Types of Properties Dialog Boxes" on page 51 
for further details on  Properties dialog boxes.

4.7  Types of Pop-up Menus
The pop-up menu are context-sensitive and will display different options 
depending on the object you have clicked.

Global State Cell and Sequence Cell Pop-up 
Menus

If you click on the Global State Cell or 
Sequence Cell (but not one of the buttons 
inside them), you will get the following 
pop-up menu: 

New Event - Brings up a menu of Event types.  This is the same menu that 
appears when you click the New Event button on the toolbar.

Properties - Brings up the State Properties dialog for the selected state.

Event Pop-up Menu
If you click on an Event button, you will get the 
following pop-up menu:  

Specify Action(s) - opens a sub-menu with the 
following options:
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• Trigger - Triggers end of recording.  Recording continues until 
post-trigger buffer is expended.  Buffer settings are controlled by the 
Recording Options - General page.

• Filter Out - Excludes selected traffic from recording. Filtering 
preserves recording memory, thereby extending recording sessions and 
excluding events of little interest.

• Advance the Sequence - Appears only in Sequence Cells and is used to 
create event sequences.  Tells the analyzer to look for the next event in 
the sequence.  

• Filter In - Includes selected traffic in recording.
• External Trigger Pulse HIGH - Sends an output signal with a Pulse 

High format through the output ports on the back of the UPAS.  Pulse 
High is the default format.  Pulse High causes the analyzer to transmit a 
5 volt, 40 nanosecond signal.

• External Trigger Pulse LOW - Sends an output signal with a Pulse 
Low format through the output ports on the back of the UPAS.  Pulse 
Low causes the analyzer to transmit a 0 volt, 40 nanosecond signal.

• External Trigger Pulse TOGGLE -This format causes the analyzer to 
transmit a signal that will toggle with each trigger event between a 
continuous 5 volt signal and a continuous 0 volt signal.

Add Counter - Displays the Event Properties dialog with the Counter 
selected and ready to accept the count value.  The menu item is not shown 
if the counter is not applicable to the selected event.  If the counter is already 
specified this menu item is replaced with Don’t Use Counter and Change 
Counter Value.

Move Event To - Moves selected event to a different position in the 
Recording Rules window.

Copy Event To - Copies selected event to a different position in the 
Recording Rules window.

Delete this Event - Deletes the selected Event.  Alternatively, you can use 
the Delete button on the toolbar or keyboard to delete events.

Properties - Opens a dialog box and lets you specify further sub-types (for 
example, types of errors) and additional conditions for the selected event. 

Action Pop-up Menu 
If you click on an Action button, you will get the following pop-up menu:  

Trigger - Sets or clears Trigger action.
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Filter In - Sets or clears Filter In action.  This 
option precludes the use of Filter Out. 

Filter Out - Sets or clears the Filter Out action.  
This option precludes the use of Filter In.

Restart All - Restarts any 
sequences or counts you may have 
set on other buttons.  The example 
on the right illustrates how the 
Restart All action works.  This 
example reads "Look for a 
sequence of five Bus Conditions 
and then trigger.  If, however, an 
Error occurs any time before the 
fifth Bus Condition has occurred, 
restart the count". 

Action menu for event in
Global State Cell.

Actions menu for event in
Sequence cell.   

Restart example.  In this configuration, 
SATracer will restart its search for a 
sequence of 5 Bus Conditions if an error
encountered.

Second restart example.  In this 
configuration, SATracer will restart
its search for the above sequence of
events if a Bus Condition is found.
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External Trigger Pulse HIGH, Pulse LOW, Pulse TOGGLE - Causes 
the event send an external signal out through the External Out port on the 
back of the UPAS.  The shape of the signal (Pulse HIGH, Pulse LOW or 
Pulse TOGGLE) must be the same for all events sending out such signal.  
This means that if you change the output signal for one event, it will 
automatically change the signal for all other events sending output signals.

Properties - Displays the Action Properties dialog for the selected state.

4.8  New Events Menu 
To add new Event buttons to the Available Events 
area, click the New Events button.  A menu opens 
with the following categories:

• Primitives
• FIS
• ATA Commands
• Data Pattern
• Bus Conditions and OOB Signals
• Errors
• Breakout Board Data
• Timer

4.9   Types of Properties Dialog Boxes
Each cell and button has a properties dialog box that allows refinement of 
the options being set. 

Properties dialog boxes can be opened by: 

• Double-clicking a button or cell.

• Right-clicking a button and selecting Properties from the pop-up 
menu.

• Clicking the Properties button on the toolbar. 

Properties dialog boxes exist for all items in the Recording Rules page:  the 
event buttons, action buttons, Global State cell and Sequence cells.
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Properties Dialog Box - General Features
Properties Dialog boxes share several features:  an Icon preview, a Label 
Icon, Channel Settings, Negation, Counter, a Pin button, and a Descriptive 
String.     

Icon Preview - The Icon Preview shows what the button currently looks 
like.  If you make changes to the Channel settings or the Icon Label, these 
changes will immediately display in the Preview.

Icon Label - A text box for labeling the button.  Whatever is typed here will 
appear on the button.

Channels - These controls allow you to select the channel(s) that the 
analyzer should search when it is looking for the event.  

Counter - A counter tells the analyzer to search for x instances of the 
selected event.  For example, if you enter "10," the analyzer will count 10 
instances of the selected event before it performs whatever action you 
assign.  There are only two counts available in the hardware so if you try to 
assign more than two, you will get a warning. 

Note Counters can not be applied to events with Filter Actions.  The 
maximum counter value is 65,535. 

Negation - Tells the hardware to match the opposite of the event.  For 
example, if you select NOT for Errors Event, the match will occur on Error 
types that are not checked.  If you select NOT for a SCSI command, the 
match will occur on any FCP_CMND except for the selected one, and also 
on the selected one if the additional parameters do not match.

Pin Button - Allows you to "pin" the Properties dialog box to the 
application so that it does not go away when another object appears such as 
an event, state or action.
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Description String - This area contains a textual description of the event.

Specific Event Settings - The largest part of the Event Properties dialog 
box.  By selecting one or more events from the list, you narrow the range of 
events that the analyzer searches for.  

The options presented in this area vary depending on the selected event.  
There are three basic formats:

• Checkboxes 

• List

• Pattern Editor

Checkboxes and Lists present options for you to select from.  Selecting one 
or more option tells the analyzer which event(s) the analyzer should search 
for.  Examples are shown below:  

The Pattern Editor, on the other hand, presents a series of text boxes in 
which you can enter a data pattern that the analyzer should search for.
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The Pattern Editor has two components:  the text boxes themselves, in 
which a pattern can be entered, and pull-down menus.  Pull-down menus are 
recognizable by the color of the field headings.  If the field heading is blue, 
it is a menu.  Click it to see the contents.  

Actions Tab - The Actions tab opens a page of options for setting  triggers 
and other actions on the selected events.    

4.10  Event Properties Dialog Boxes - Descriptions
Each event button has a Properties dialog box opens with options for further 
specifying the type of event that the analyzer should look for.  Selecting an 
option narrows the search pattern to the selected event.

To open a Properties dialog box for an event button, double click it.
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Properties dialog boxes have two pages of options:  one listing event 
sub-categories, and the other listing actions. Below is an example.   

There are properties dialog boxes for each of the event categories listed in 
the New Events menu.  Each dialog is described in this section. 

Category Event

Primitives Primitive Categories
Primitives

FIS Register Host to Device
Register Device to Host
Set Device Bits
DMA Activate
BIST Activate
PIO Setup
Data
Route
Vend FIS:  0xFF

ATA Commands

Data Pattern

Bus Conditions and OOB Signals
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The descriptions below follow the order of events listed in the table above.

PRIMITIVES
There are two types of primitive events:  Primitive Categories and 
Primitives.

Primitive Categories Properties Dialog
Presents options for triggering or filtering on various Primitive categories.  
If NOT is checked, any unchecked primitive category will generate an event 
match. 

Errors

Breakout Board Data

Timer

Category Event
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Primitives Properties Dialog
Presents a menu of Primitive types.  Selecting a Primitive from the list 
narrows the analyzer’s search to just the selected Primitive.  Afterwards, a 
trigger or filter can be set on the selection.  If NOT is checked, any 
unchecked primitive will generate an event match.  

FIS
There are ten SATA FISs that can be selected from the New Events menu:  
Register Host to Device, Register Device to Host, Set Device Bits, DMA 
Setup, BIST Activate, PIO Setup, Data, Route, and Vend FIS: 0xFF.

The Properties dialogs for these FISs are similar to one another.  They 
display data fields for entering data patterns on a bit-by-bit basis.  Entering 
a data pattern tells the analyzer to search for the specified pattern.  If NOT 
is checked, any pattern other than the one specified will generate an event 
match. The FIS Types properties dialog presents options for triggering or 
filtering on several different FIS categories.  An example (Register Host to 
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Device) is show below.  Each FIS Properties dialog box displays a pattern 
editor that allows you to set a bit pattern to be matched.  If NOT is checked, 
any unchecked primitive category will generate an event match. 

Note that some of the data fields have drop-down menus.  To see which 
fields have menus, position your mouse pointer over the blue field headings.  
If the pointer changes into a hand, then the heading will present a menu if it 
is clicked.   

ATA COMMANDS
ATA Commands are presented in a single dialog box.    

ATA Commands Properties Dialog
Presents several options:

Commands - Presents a long list of ATA Commands.  Selecting a 
command will cause the analyzer to search for the selected command.

Features - A text box for entering a value.

Sector Count - A text box for entering a Sector Count value.

LBA Mode - Select the radio button, then enter a value.
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Sector/Cylinder/Dev/Head Mode - Select the radio button, then enter 
values into the text boxes.  

 If NOT is checked, any unchecked primitive will generate an event match.

ATAPI COMMANDS

Individual ATAPI 6/7 commands can be selected as a trigger event. Resource 
limitations restrict ATAPI triggering to a single channel and to a single ATAPI 
event.   

ATAPI Command Properties Dialog
To specify ATAPI commands as the recording event, select the command 
using the Operation Code or Command name. Additional ATAPI 
parameters can be specified by entering bit-level pattern in binary or 
decimal including LUN, transfer length and LBA.  
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BUS CONDITIONS AND OOB SIGNALS
Bus Conditions and Out of Band Signals are presented in a single dialog 
box.

Select from the check boxes to specify the type of Bus Condition or OOB 
Signal that you want the analyzer to search for.  

If NOT is checked, any unchecked primitive will generate an event match. 

ERRORS
Errors are presented in a single dialog box.  

Select from the checkboxes to specify the type(s) of errors you want the 
analyzer to search for.  If NOT is checked, any unchecked primitive will 
generate an event match.  

BREAKOUT BOARD DATA
Breakout board data are entered into a single dialog box.  
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The Breakout Board Data properties dialog box lets you specify a bit pattern 
from a breakout board that can be used for triggering.  If NOT is checked, 
an event match will be created for any pattern other than the one specified.  

4.11  State Properties Dialog
The State Properties dialog allows you to specify the Global state’s caption. 
To access this dialog box, click in the Global State Cell (but not on an Event 
button).  
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Timer Properties Dialog
Specify the value for the timer in seconds, milliseconds, microseconds, and 
nanoseconds.  The actual timer value is shown below the edit controls and 
reflects the hardware precision capabilities.  The time is rounded up to the 
next 7.519 nanosecond sample, which corresponds to the 1.33 MHz internal 
clock frequency.  

4.12  Assigning Actions
As shown above, you can double-click an Event or Action button to open 
the Properties dialog box, and then select the Actions tab.  You can then 
select an action from one of the options.

The assigned action will be represented by a button to the 
right of the Event button.

You can also assign an action by right-clicking on an Event or Action button 
and selecting an action from the pop-up menu.
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The following table shows the types of Actions you can select. 

4.13  Setting Conditions:  The Role of the Global State 
Cell 

The Global State cell is the arena in 
which you create triggering and/or 
filtering conditions. The cell is called 
the Global State cell because the 
conditions you create are active at all 
times. You can think of these conditions as the default conditions.  You use 
the Global State cell to create simple condition such as "Trigger when you 
see an xxx error," or "filter out all xyz primitives."

Action Comment 

TRIGGER 

Triggers the end of the recording.  
The end point of the recording is 
determined by the buffer settings in 
the Recording Options General 
page. 

FILTER OUT 

FILTER IN 

Filters traffic in or out of the 
recording - thereby conserving 
recording buffer space. 

Can not be assigned to the events 
with Counters.  

RESTART ALL Reinitializes counters.  
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Example - Creating a Simple Event Trigger
To create a simple condition that is active at all times, place an event button 
in the Global State cell:

Step 1 Click the New Event button.  An 
Events menu opens (shown right).  

Step 2 Select an event from the menu.  The 
event will appear as a button in the 
Available Events area on the left.

Step 3 Drag the event button to the cell 
marked "Global State."

Step 4 Right-click on the button (i.e., not the 
Global State cell).  A pop-up menu 
appears.

Step 5 Select Trigger from the menu.  An arrow will project from the error 
button and point to a cell marked Trigger.

Creating Multiple Event Conditions in the Global State Cell
When multiple buttons are placed in the Global Cell, it creates an "AND" 
condition or an "OR" condition depending on the actions selected.  

Creating an OR Condition - When two or more buttons in the Global State 
cell are assigned the same action, the analyzer will search for all of the 
events and perform the action on which ever event it sees first.  The example 
below illustrates.  It reads "Trigger if an error or a primitive occurs".  

Creating an AND Condition - When multiple events are placed in the 
Global State cell and assigned different actions, an AND statement is 
created.  The example below reads "Trigger if an error occurs AND filter out 
any primitives that occur." 
64



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
Filter In and Filter Out
A filter causes the analyzer to filter in or out specified events from the 
recording. If events are filtered out of the recording, they are excluded and 
not simply hidden from the trace. The purpose of filtering is to preserve 
recording memory so you can conduct longer recording sessions and 
exclude events that do not interest you.

To Filter In or Out traffic,

Step 1 Click the New Event button.  The New Event menu opens.

Step 2 Select an event from the menu.

Step 3 Drag the event into the Global State cell.

Step 4 Right-click on the button.  A pop-up menu opens.

Step 5 Select Specify Action(s)

Step 6 Select Filter Out (for example).

The analyzer is now configured to filter out the selected event. 

Filter In or Out Everything
The options Filter Out Everything or Filter In Everything allow you to 
filter all traffic in or out of the trace.  These options are intended for a future 
release to allow you to selectively exclude and include traffic from a 
recording.  

Counting Events
In addition to setting triggers and filters, you can also set counters.  A 
counter is an action that allows you to set a trigger based on a count of 
events. For example, you could use a counter to "Trigger following the 16th 
occurrence of an error."

To use a counter, follow these steps:

Step 1 Select an event from the Select Event menu and drag it to the Global 
State Cell in the center of the dialog box.

Step 2 Click the small channel buttons on the selected Event button to 
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select the channels for the actions.

Step 3 Right-click the event and select Add Counter. A dialog box opens.

Step 4 In the text box to the right of the label Count enter a value. 

Step 5 Make sure the checkbox to the left of the label Count is checked.

Step 6 Click the X in the top right corner of the dialog box to close the 
dialog. A counter button should appear below your selected event.
66



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
4.14  Creating Event Sequences
Event sequences are chains of events leading to some action. A sequence is 

a multi-event "if, then" condition:  "If x followed by y followed by z occurs, 
trigger."  Event sequences are created by dragging two or more buttons into 
the Sequence cell.  The Sequence cell is a faintly marked cell just below the 
Global State cell.  The Sequence cell contains the text Drag an event here 
to add a new sequence.  

Note Event sequences can only be created in the Sequence cell.  You 
cannot create a sequence in the Global State cell. 

States
Sequences are made up of cells called States.  A state is a stage within a 
sequence that specifies what events the analyzer should look for and what 
actions to apply when the event occurs.

In the example below, the Sequence is composed of two states.  The 
maximum number of states a sequence can support is 255. 
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The foregoing example reads:  "Trigger if you see a Primitive followed by 
an error."  

How to Create an Event Sequence
To create an event sequence, you drag event buttons to the Sequence cell,  
link them with the action Advance the Sequence, then apply a trigger or 
other action to the end of the chain.  The following steps illustrate how to 
create an event sequence.

Step 1 Click the New Event button.  The New Event menu opens.

Step 2 Select an event type from the menu, for example an error.  A button 
appears in the Available Events area.

Step 3 Click the New Event button and select a second event type, for 
example a Primitive.  At this point, you should see two buttons in the 
Available Events area.  

Step 4 Drag the first button to the cell marked "Drag an event here to create 
a sequence."  When you finish, notice how two new cells appear in 
the window as shown below the cell where you placed your button. 
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Step 5 Double-click on the button.  A Properties dialog box opens.  

Step 6 Select desired options from the dialog box, for example an error 
sub-type.  The options apply immediately.  

Step 7 Close the Properties dialog box by clicking the X in the top right 
corner.  The Properties dialog box closes.

Step 8 Drag the second event button to the cell immediately below the cell 
occupied by your first event button.  Note that an additional cell 

appears marked "Drag an event here to add a sequence."

Step 9 Right-click on the first event button.  A pop-up menu appears.  

Note Be sure to click on the button itself and not the cell.  If you click the 
cell, you will get a different menu with fewer options.
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Step 10 Select Specify Actions.  Notice 
how this menu differs slightly 
from the menu shown earlier in 
this chapter.  You will see three 
options for advancing or 
restarting a sequence:

• Advance the Sequence - 
Draws an arrow that connects 
the selected event button to the 
event button below it.  This option creates a sequence.

• Restart the Sequence - (Not visible in the menu above.)  This 
option restarts the entire sequence.  This option appears once you 
have linked two or more buttons in a sequence.  This option  
draws an arrow upward from the selected event button to the 
beginning of the sequence.  

• Restart All - Restart all sequences and counts.  This option 
creates an arrow pointing a cell marked "Restart All."   

Step 11 Select Advance the Sequence.  An arrow will appear that connects 
the first button to the second.

Step 12 Right-click the second button and select Specify Actions.  A 
sub-menu appears.

Step 13 Select Trigger.  A cell will appear to the right of the second button 
saying "Trigger."  Your sequence configuration is now complete and 
should look like this:
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Using a Timer
Timers let you set a time-delay for a trigger or other action. The following 
example illustrates how timers work. 

This example reads "Look for a Primitive.  When you see one, wait three 
seconds then trigger."

To create the example shown above, perform the following steps:

Step 1 Click the New Event button to open the Event menu.

Step 2 Select an event such as Primitive from the menu. An event button 
appears in the Available Events area.

Step 3 Drag the event button into a Sequence cell marked "Drag an event 
here to add another state."  Once the button is added, the cell turns 
blue and acquires a title like "Sequence 1, State 1."  Below the cell, 
a new cell appears  marked "Drag an event here to add another 
state."

Step 4 Click the New Events button.  The Events menu opens.

Step 5 Select Timer.  A Timer button appears in the Available Events list.

Step 6 Drag the Timer Button to the cell marked "Drag an event here to add 
another state."   The cell turns blue and acquires a title like 
"Sequence 1, State 2."

Step 7 To link the two events into a sequence, right-click on the first event 
(in our example, the Primitive event button).  Be sure to click on the 
event button and not on the cell.  A pop-up menu appears.

Step 8 Select Specify Action(s).  A sub-menu opens.

Step 9 Select Advance the Sequence.  The menu closes and an arrow 
appears that connects this cell to the State cell below.

Step 10 Right-click on the Timer button.  A pop-up menu appears.

Step 11 Select Specify Action(s).  A sub-menu opens.

Step 12 Select Trigger.  The menu closes and an arrow appears that 
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connects the Timer button to a new cell to the right marked Trigger.

Step 13 To set the duration of the Timer, double-click on the Timer button.  
A dialog box appears. 

Step 14 Enter a time value in the boxes.

Step 15 Click the x to close the dialog box.  The timer is now set.
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4.15  Recording Options - Channels
The Channels page allows the channel names to be customized.  To change 
a channel name, select the channel, then click the edit button and enter the 
new text, then click OK.  Once the options are set, the analyzer will update 
the open trace and all future traces with the new channel names.  

Note You can also change channel names by clicking on the first cell 
of a trace (the channel cell) and selecting Rename Channel 
from the pop-up menu.

Where Custom Channel Names Appear
Custom channel names appear in three places:  

• The trace itself

• Link Tracker window

• Frame Tracker window

• Bus Usage window  
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Custom Channel Names in the Trace - Custom channel names do not 
appear right away in the trace:  the original names continue to display.  To 
see the custom channel names, click in the first cell of the trace (the channel 
cell) and select Format from the pop-up menu, then select Custom. 

The custom names will then appear in the trace.  

Custom Channel Names in the Link Tracker Window - The Link 
Tracker window will automatically show custom channel names as soon as 
they have been customized. 

Custom Channel Names in the Bus Usage Window - Custom Channel 
names automatically appear in the Bus Usage window as soon as they have 
been customized.  The easiest way to see this is to open the Bus Usage 
window and then to open the Properties dialog for the window.  It will list 
the custom channel names.

Channel I2 renamed as Init_2.
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To open the properties dialog box for the Bus Usage window, right-click in 
the window, then choose Properties from the pop-up menu.  
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5.  Display Options
Use the Display Options menu to specify the way CATC Trace information 
is displayed.

From the Setup menu, select Display Options.  

5.1  General Display Options
Use the General Display Options to specify the basic appearance of a Trace 
view.

• Zoom Level: Adjustable in discrete increments from 10% to 200% 
percent.

• Enable Tips: Select to enable Tool Tips with explanation text to 
pop up when you position your cursor over various fields in the 
Trace View.

• Wrap: Causes packets to wrap within the window if their length 
exceeds the width of the window.
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• Hierarchy Lines:  Adds faint lines (shown 
right) to the left side of the trace showing 
the hierarchical relationship of the Frames, 
Transactions etc within the trace.  When 
this option is enabled, the lines display any 
time you cascade higher level decodes.

• Right click cell context menu:  Activates 
the right mouse button for opening cell context menus.

• Timestamp At The Beginning:  Moves the timestamp from the 
end of the Frame to near the beginning.

• Trace Viewing Level: Allows you to select the hierarchical level at 
which traffic is displayed.

• Analysis Tools:  Displays report windows such as Link Tracker 
and Bus Utilization.

• Fonts:  Sets fonts used in trace fields. 
• Display Configuration Name: Comment field associated with the 

*.opt file containing the current Display Options values. You can 
also create and store your unique Display Options for future use. 

To create a new Display Options file, follow these steps:

Step 1 Enter a comment for the new file in the Display 
Configuration Name field.

Step 2 Click Save...

Step 3 Specify a filename (*.opt).

Step 4 Click Save.
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5.2  Setting Color, Formatting, and Hiding Options
Click the Color/Format/Hiding tab on the Display Options screen.  

Use this window to customize the colors and formats associated with each 
field in the Trace view. You can also use this window to hide fields within 
the trace.

Setting Color Display Options 
To change the colors of elements in the trace, select an item in the Group 
and Color column and use the color pallet screen on the right to make the 
desired changes.

Note The color of an Invalid Data (packet error) field cannot be 
changed; it is permanently set to red.

Use this window to customize the colors associated with each field in the 
trace.  You can experiment with these options to achieve the color 
combination best suited to a particular graphic system.
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You can also customize the colors by using the options in the Custom tab. 

Changing Field Formats
To change field formats, select an item under the Group and Color column.  
This action will enable the formats radio buttons on the right.  The format 
types change with respect to the item selected under the Group and Color 
column.  For example, if Display Units is selected, the following displays: 

The following formats are available:

Note Not every format is available for every item.
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Hiding Display Options
To hide one or more fields in the trace, select the 
appropriate item from the Group and color column, click 
the checkbox marked Hidden, and click the Save button. 

You can also hide Frames from a trace by selecting the desired options from 
the checkboxes.   

5.3  Level Hiding Options
The Level Hiding tab allows you to hide various types of traffic.  To hide 
traffic, select one or more items from the Events Group list and from the list 
on the right, then click OK. 

5.4  Saving Display Options 
To complete your display options settings, use the features at the bottom of 
the Display Options window. These features remain the same no matter 
which of the four Display Options windows you are working in.

• Click Save to save the currently specified display options for use in 
future sessions. Any file name can be specified, but you must use 
the .opt extension. If no extension is specified, .opt is added by 
default.
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• Click Load to load a previously saved *.opt file, thus restoring a 
previous set of display options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.opt. Whenever you start up the 
Analyzer, it automatically loads the default.opt file if one exists.

• Click OK to apply any changes you have made to Display Options 
and close this dialog box.

• Click Cancel to cancel any immediate changes you have made and 
exit the Display Options menu.

• Click Apply to apply your changes while keeping the Display 
Options window open.
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6.  Reading a CATC Trace

6.1  Trace View Features
SATracer/Trainer trace viewing software display makes extensive use of 
color and graphics to fully document the captured traffic.  Frames are shown 
on separate time-stamped rows, with their individual fields both labeled and 
color coded.  Data fields can be collapsed to occupy minimal space in the 
display (which can in turn be zoomed in and out to optimize screen 
utilization).  Pop-up Tool Tips annotate Frame fields with detailed 
information about their contents.

The display software can operate independent of the hardware and so can 
function as a stand-alone Trace Viewer that may be freely distributed.

6.2  Frame, Transport, SCSI, and Management Views
The default display mode is Frame view.  The trace can also be viewed in 
Transport Layer (Tra), SCSI Application Layer,  Management Application, 
ATA Application Layer views.

Changing Display Levels 
To switch between the Frame, FIS, and ATA Command 
application views, click the respective buttons on the  Tool 
Bar.
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Frame Layer
Frame Level view is the default decode level.  Frame Level view displays 
traffic as shown below: 

FIS Layer 
When you click the FIS button, FIS Layer traffic is decoded and presented 
as shown below.  To see FIS Layer transactions, you may need to scroll 
through the trace or use the Find command (under Search).

ATA Application Layer
When you click the Cmd button, ATA Application Layer traffic is decoded 
and presented. 

You can "open" any of these decode levels to reveal the components by 
clicking the small triangular in the first cell. The following is an example of 
an expanded ATA Command Level view showing its constituent FIS Layer 
Transactions and Frames:

You can also get additional information on fields by holding your mouse 
over selected fields as shown in the following example:
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You can also set the hierarchical view by selecting checkboxes in the Trace 
Viewing Level Options in the Display Options window. 

6.3  View Raw Bits
SATracer allows you to view low-level 8B/10B values for Serial ATA 
traffic. You can expand a specific Frame to view the raw bits by right 
clicking on the Frame number and selecting Show Raw Bits. 

To view Raw Bits, follow these steps:

Step 1 Click on the first cell of a Frame.
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Note Raw Bits can be viewed only in Frames.

Step 2 Select Show Raw 10b Codes. 

The data 8b and 10b field can be displayed in several formats, as 
shown below.

Data Appearance - To change the format of the data, select from following 
options:

• 8b - Click the column heading to show hexadecimal values.

• 10b - Click the column heading to show hexadecimal values.

Navigation - To move to the previous or next packet in the trace, click one 
of the two buttons at the bottom of the window:

• Prev - Displays data for the previous Frame in the trace.

• Next - Moves to the next Frame in the trace.

Running Disparity Error - If SATracer detects Running Disparity Errors 
it will display in red and have exclamation marks before and after the value.
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The 8-bit codes change to 10-bit codes before they get transmitted. 

Running Disparity
Running Disparity is a binary parameter with either the value negative (-) or 
the value positive (+). After receiving any encoded character, the receiver 
shall determine whether the encoded character is valid using the running 
disparity parameter as a checksum.  The receiver will then calculate a new 
value that is either the opposite of the previous character or neutral. The 
ability to view changes in Running Disparity polarity is an important part of 
the debug process.  The CATC raw bits view displays the running disparity 
of the 10bit code in the column following the raw bits. 

6.4  Expanding and Collapsing Data Fields
You can expand a Data Payload field to view it in greater detail or collapse 
it when you want a more compact view. SATracer/Trainer allows you to 
expand and collapse the data payload information in four ways: 

• Clicking the small triangular arrows on the left side of the data 
payload field

• Clicking and holding down the mouse button on the triangular 
button on the left side of a data payload field. This action will 
expand or collapse data fields for all Frames throughout the trace

• Double-clicking anywhere in the payload field
• Clicking in the data payload field and selecting Expand/Collapse 

Data in the pull-down menu. 
When you select "Expand Data," only the first 100 dwords are shown. To 
view all of the dwords, select "View Data Block."

This section describes expanding or collapsing data payload by using the 
menu:

Step 1 In the Serial ATA trace, click in a Data Payload box.
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Step 2 In the Data Field menu, select Expand Data.

The Data Payload box expands to show more detailed description 
of the data:

To collapse data, follow the same steps described above, and select 
Collapse Data. 
You can also expand or collapse all data payload fields within a 
trace by using the above menu. 

6.5  View Data Block Window
The View Data Block command opens a dialog box that lets you display and 
navigate the data within Frames and Transport Layer transactions.  This 
dialog box gives you several format choices for the data:  binary, 
hexadecimal, ASCI, and decimal.  It also gives you the ability to navigate 
through data fields within different Frames and Transport Layer 
transactions.

To access the View Data Block window,

Step 1 Decode to the level of interest by pressing    or .

Step 2 Locate a Frame or FIS transaction with a data field such as the one 
shown below: 

Step 3 Click in the Data field to open a pop-up menu.

Step 4 Choose View Data Block from the menu.  The View Data Block 
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window opens.  

Description of View Data Block Window
The View Data Block window (henceforth called the View window) 
displays the raw data for the selected Data field.  Data is displayed in up to 
four formats, a column per format.  The window has several options for 
navigating through Data blocks.

 Save. Saves the currently displayed data block into a text file.

 Previous and Next. These buttons cause the View window to jump 
to the next Frame that has a data block and display that data block.

 Data Format Display. Creates a column for the 
specified data format and then displays the currently selected data block in 
that format.

 MSB/LSB Format. Begins the data string with the Most 
Significant Bit (MSB) or Least Significant Bit (LSB).

 Format Line. Opens a dialog box for setting DWORD length. The 
default is 4 dwords.

 Synchronize Options. Configures the mouse's 
scrolling behavior within the View window. 

The menu presents three scrolling options:

• Update only on request - Locks whatever data block currently is 
on display in the Data window unless overridden by a direct 
request. There are two ways to make a request -- by clicking on 
the buttons or by right-clicking in the trace on a data block and 
selecting View Data Block from the pop-up menu.

• Update on click - Repositions the Data window to whatever data 
block you click on in the trace window.

• Update on scroll - Synchronizes trace scrolling with the Data 
window. As you scroll the trace, the Data window will reposition 
to show the data block for the Frame at the top of the trace 
window.
 89



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
  Scroll to Offset. Repositions the Data window to whatever 
offset you enter in the Offset box. You can enter an offset value in decimal 
or hexadecimal.

6.6  Export Options
Trace data captured by SATracer can be exported for other uses, including 
uses outside the system.  These options are accessed through the File menu 
by selecting Export, as shown below.

There are four export options supported.  The data fields which will be 
present in the exported files are determined by the current screen view.  
Please select the appropriate data fields before exporting the data to ensure 
that the correct information is present in the exported file.

Packets to Text (Packet View Format)
This option is used to create a text version of the trace (e.g., for use when 
emailing a trace section).  Selecting this option brings up a screen to allow 
you to define the range of events that you want to include in the text file.  
The range can be defined by frame number, by markers, or by time.
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Define the range of events (by frames, markers or time) that you would like 
in the exported file and click "OK".  A screen will appear for you to provide 
a filename for the exported file, and allow you to navigate to the folder 
where you wish to store the file. The exported file will have a ".txt" 
extension.

Export to Generator File Format
A feature of the SATrainer is the ability to use a trace captured by the 
SATracer as the basis for traffic to be generated by the SATrainer.  In order 
to use this feature, the captured trace must first be exported by using the 
"Export to Generator File Format" command.  See Generating Traffic on 
page 156 for a discussion on how to use this feature with the SATrainer.

Packets to EAS Format
This option creates EAS files based on the open trace.  Selecting this option 
will bring up a screen allowing you to name the files and navigate to the 
folder that you would like to store the files.  There are three files created, 
one file with a ".ecs" extension and two files (one for each channel) with a 
".eas" extention.  The ".eas" files will have "_000_ch1" and "_000_ch2" 
appended to the file name you provided.

Export to CSV Format
Many users might wish to have the trace data exported into a formatted file 
(e.g., for import into databases or spreadsheet programs such as Microsoft 
Excel).  The "Transport to CSV Format" option provides a means of 
generating a structured file from trace data captured by SASTracer.

Selecting this option will bring up a screen allowing the user to specify the 
information from the current file to be exported and the destination file for 
the exported data.
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Select the destination folder and enter the destination filename for the 
exported data.  Select the layer to export (either Transport or ATA 
Application Layer).  Indicate whether you would like hidden packets to be 
included in the exported file or just displayed packets.  Define the range of 
events (by frames, markers or time) that you would like in the exported file 
and click "Save".  

The exported file will have a ".csv" extension.  The first line (or record) in 
the .csv file will be a header indicating the name of each variable included 
in the file.  Each following line (or record) will contain only data.

If opening the exported file from within Microsoft Excel, in the Open File 
window under "Files of Type:" select "Text Files (....; *.csv)". When the file 
is opened, a spreadsheet is shown with a large number of columns (each 
column representing one data type) and a number of rows on the trace which 
was selected for export.  A typical spreadsheet is shown on the next page.  
Once opened, the file can be later saved as any supported Excel file type. 
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7.  Reports
The Report menu provides several reports to assist you in analyzing traffic 
recorded by the Analyzer.  

7.1  File Information
To display data on a trace, select Report >File Information from the menu.

The File Information dialog opens and provides information about the 
recording such as trace date and the version of the Analyzer Firmware and 
BusEngine used to record the traffic.

One of the most useful pieces of information in the dialog is the Recording 
Options settings used to create the open trace.  These settings are listed 
under the heading Recording Options shown in the above screenshot.  
Below the settings is a blue hypertext link that reads Open Recording 
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Options in a dialog.  When clicked,  this link causes the software to open 
the Recording Options dialog and automatically populate the dialog with the 
settings used to create the trace.  This link provides a simple and easy way 
of loading the options directly into the Recording Options dialog.

7.2  Traffic Summary
The Traffic Summary displays a report of traffic in the SATracer and 
appears at the bottom of the SATracer main window. The left side contains 
a tree view where you can expand or collapse types of data you want 
displayed to the right of the Traffic Summary window. You can print, 
e-mail, save to disk, or display data in a two-column table by using the 
buttons in the Traffic Summary tool bar. 

From the Report menu, select Traffic Summary. 

Navigating
The Traffic Summary window also functions as a trace navigation tool.  If 
you click one of the numbers in the right side of the window, the trace will 
jump to the first instance of your selection.  Afterwards, click the up or down 
arrows at the top of the Traffic Summary window to navigate forward or 
backward through the display.

Buttons
Buttons at the top of the Traffic Summary window serve to format the 
display and export summarized data to email, file, or the printer:
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The buttons have the following functions:

7.3  Error Summary
The Error Summary button opens the Traffic Summary window and 
displays a list of errors analyzed throughout the recording.

Step 1 From the Report menu, select Error Summary.

The Traffic Summary window appears with Error information 
displayed.

Step 2 Navigate to an error within the recording by clicking the number of 
the Frame containing the error.

Step 3 Use the arrows to cycle though each occurrence of a particular error.

7.4  Timing Calculations
The Timing  measures timing between any two specified Frames or 
markers. The timing calculator feature is designed specifically for tracking 
bus utilization and I/O performance in current or previously captured trace 
files. By default the statistics will be calculated on a complete capture file 
or one bounded between markers or between any two Frames. 

To run the Timing Calculator, perform the following steps:

Save As -  Saves Traffic 
Summary results into an 
HTML format

Displays results tabular text format

Email - Creates an email 
with a *.html file 
attachment of the graphs  

Displays drop-down menu with:

Grid Lines - Displays/Hides grid lines

Row Selection - Allows entire rows to be selected

Tight Columns - Reformats column widths to 
match data

Print
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Step 1 From the Report menu, select Timing Calculations. 

Step 2 Select the range, and click the Calculate button.  The results will 
then display in the window.

7.5  Bus Utilization
The Bus Utilization window displays information on bandwidth use.  

To open the Bus Utilization window, select Report >Bus Utilization or 
click the button marked  .  A window opens like the one shown below:  

Window Layout
The Bus Utilization window divides into two areas:
98



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
•   Graph Area - Displays graphs. Initially, no graphs will be 
displayed. To display one or more graphs, click  and make a 
selection from the menu. See “Graph Areas Menu” on page 101 
for an explanation of the types of graphs listed in this menu.

• Min/Max/Avg Area - Displays the minimum, maximum, and 
average values for several parameters.  Data is available only 
after you have displayed the relevant graph.  After displaying a 
graph, the Min/Max/Avg information is calculated and is 
thereafter available to the user even if the graph is closed.  The 
user can close this section by clicking  and deselecting 
Statistics Accumulation from the menu. 

Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of 
the displayed data and for exporting data:

The buttons have the following functions:

Save As - Saves the graphs 
as a bitmap file (*.bmp) Vertical zoom in

Email - Creates an email 
with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print

Click and Drag zoom - Click diagonally to 
select and zoom in on part of the graph.  The 
initial direction you begin dragging the 
cursor determines whether the horizontal or 
vertical axis is magnified.

Full Screen Select Range

View Settings - opens a 
sub-menu with options for 
formatting the display. See 
“View Settings Menu” 
below

Sync and Graph areas - If two or more 
graphs are displayed, this button will 
synchronize the graphs to one another.  Once 
synchronized, the positioning slider of one 
graph will move the other graphs

Horizontal zoom in

Graph Areas - Presents a menu of graphs for 
various types of bus data

Horizontal zoom out
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View Settings Menu
Clicking the View settings button  causes a menu to 
open with options for formatting the display.

• Orient Horizontally - changes the orientation of 
bus usage to horizontal.  After selecting this 
option, the menu will say "Orient Vertically."

• Tile Vertically - tiles the two graphs vertically 
(i.e., side by side).

• Show Markers - Places "tick" marks along the x 
axis of each graph.

• Show Plumb Line - Displays a vertical line that connects your 
cursor to the horizontal axis. As the mouse is moved, the status bar 
will show the packet and time frame to which the cursor is pointing.

• Status - Opens a sub-menu with the following options:

— Bar - Displays a status bar at bottom of graph.

— Tooltip - Causes a tooltip to appear if the mouse pointer is positioned 
over part of the graph and left there for a couple of seconds.

— None - Turns off tooltips and the status bar.

• Grid Lines - Opens a sub-menu with the following options:

— Both - Displays both X and Y axis gridlines

— X Axis - Displays X axis gridlines

— Y Axis - Display Y axis gridlines

— None - Turns off gridlines

• Grid on Top - Moves the grid lines above the graph.

• Fonts and Colors - Opens a dialog box for setting the colors and 
fonts used in the graphs:
100



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus 
Utilization window. 

Step 1 Click the button.

The Graph Areas menu opens. 

Step 2 Select a graph type from the menu.  Repeat for additional graphs.  

Modifying the Appearance of Graphs
To modify a Bus Usage graph, follow these steps below.

Step 1 With a graph displaying in the Graphs Area, right-click 
anywhere in the graph and choose Properties from the 
pop-up menu.   The following dialog box opens.

Step 2 Select an a data type from the box on the left, then edit the Title, 
Appearance, Type, or Color boxes as appropriate.

Step 3 Click OK to apply the changes.
 101



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
Creating a New Graph
To create a new graph, 

Step 1 Click .

Step 2  From the menu, select New ... 

Step 3 From the Title, Appearance, and Type boxes, select the desired 
options.

7.6  Link Tracker Window
The Link Tracker window displays a detailed chronological view of 
events.  Events are shown on a primitive-by-primitive basis within columns 
within the window, each column representing a channel.  Time is presented 
as rows.  Idle time is shown by empty rows in the window.  Idles can be 
collapsed into gray strips running across the window.

Each time slot in the vertical axis represents the minimum time required by 
a dword to traverse the bus.  

The time slots are not fixed in size:  they vary depending on how zoomed 
out the display is.  When the Link Tracker is fully zoomed in, time slots for 
1.5 G traffic measure 26.66 ns and time slots for 3.0 G traffic measure 13.33   
ns.

When the Link Tracker window is fully zoomed out, the grid lines disappear  
and the scale changes to 1 dword equaling a line measuring one pixel in 
height.

Opening the Link Tracker Window
To open the Link Tracker window, select Report > Link Tracker or click 
the button marked  .  A window opens like the one shown below:  
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Window Layout
The Link Tracker window divides into two areas:

•   Toolbar - Presents buttons for changing data format.

• Main Display Area - Displays traffic chronologically as it 
occurred in the recording.  The window divides into columns:  the 
first column shows time and traffic is shown on a channel by 
channel basis in the columns on the right. 

Link Tracker Buttons
The Link Tracker window has a row of buttons for changing the format of 
the displayed data and for exporting data:

The buttons have the following functions:

Full Screen 

View Options.  Opens a menu 
with three options:  Collapsible 
Idle Time, Tooltip Display, and 
Reset Column Widths. See View 
Options Menu below for 
descriptions.

Synchronize Trace View.  
Synchronizes the Trace View and 
Link Tracker windows so that a move 
in one window repositions the other. 
Because of the differences in scale 
and logic between the Link Tracker 
and Trace view windows, scrolling 
produces different effects depending 
on which window is being scrolled.  
Scrolling in the trace window causes 
the Link Tracker window to rapidly 
jump from event to event. Long 
periods of idle time are skipped. 
Scrolling in the Link Tracker 
window, in contrast, causes small 
moves in the trace window. Scrolling 
in the Link Tracker window causes 
the trace window to pause until the 
start of a packet is displayed.  At that 
point, the trace window  repositions 
itself. While scrolling through idle 
periods or the contents of a packet, 
the trace window will not move.

Zoom In

Zoom In
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View Options Menu
Clicking the View Options button  causes a menu to open with options for 
formatting the display.

• Time Format- Lets you set the Time format in Link Tracker to 
Seconds or Clocks.  

• Reset column widths - This option resets column widths to their 
defaults and enables columns to resize themselves automatically any 
time the application window is resized.  

Normally, columns will automatically resize themselves if the 
application window is made larger or smaller.  However, if you 
manually resize any columns in the Link Tracker window, column 
widths become static.  Thereafter, if you resize the application 
window, the Link Tracker columns will not adjust automatically.  
Reset Column Widths re-enables this automatic resizing 
capability.

Docking and Undocking the Window
You can undock the Link Tracker window by double-clicking on the blue 
title bar along the left side of the window.  Once undocked, the window can 
be dragged anywhere in the application.  To redock, double-click again on 
the title bar.

Setting Markers
Markers can be set on any dword on any event within the Link Tracker 
window.  To set a marker, right-click on an event, then select Set Marker 
from the pop-up menu.  Once marked, events can be easily navigated to via 
the Go to Marker command in the Search menu.    
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Calculating Time between Dwords
You can calculate time between dwords by clicking on a specific cell and 
then positioning your mouse pointer over a second cell. A tooltip will 
display the time delta between the two cells.

Step 1 Click on the cell for the first event to select it.   

Step 2 Scroll down through the trace to the second event and position the 
mouse pointer over the event.  A tooltip will appear showing the 
time interval between the first and second events.  

More about Cell Selection
When searching for a frame or primitive within Link Tracker, the found cell 
will become the selected cell. When a cell is selected, it will remain selected 
even if it's off the screen. Keyboard actions in LinkTracker (scrolling, arrow 
key, etc...) will not affect the selection. Once a cell is selected, it can only 
be deselected by switching the selection to another cell. 

Hiding Traffic
You can hide Aligns, Channels and other data from the Link Tracker 
window by clicking the Hide buttons on the toolbar in the Trace window 

 or by selecting one or more of the various Hide options in 
the Display Options dialog box. 

Searching
When the Trace view and Link Tracker windows are synchronized, the Find 
and Go To options in the Search menu will apply to the Link Tracker 
window.  The Trace and Link Tracker windows can be synchronized by 
selecting the Synchronize button .
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Zooming In and Out
Zooming out can give you a quick, high-level view of a trace.  

7.7  Frame Tracker Window
The Frame Tracker window displays a detailed chronological view of 
traffic on a Frame-by-Frame basis.  Events are shown within columns 
within the window, each column representing a channel.  Time is presented 
as rows.  Idle time is shown by empty rows in the window.  

Each time slot in the vertical axis represents the minimum time required by 
a Frame to traverse the bus.  

Opening the Frame Tracker Window
To open the Frame Tracker window, select Report > Frame Tracker or 
click the button marked  .  A window opens like the one shown below:  

Window Layout
The Frame Tracker window divides into two areas:

•   Toolbar - Presents buttons for changing data format.

• Main Display Area - Displays traffic chronologically as it 
occurred in the recording.  The window divides into columns:  the 
first column shows time and traffic is shown on a channel by 
channel basis in the columns on the right. 

Frame Tracker Buttons
The Frame Tracker window has a row of buttons for 
changing the format of the displayed data and for 
exporting data:
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The buttons have the following functions:

View Options Menu
Clicking the View Options button  causes a menu to open with options for 
formatting the display.

• Time Format- Opens a menu with options for setting the time 
format.  There are two options: 

• Seconds 

• Clocks  

• Reset Column Widths  - This option resets column widths to their 
defaults.

Normally, columns will automatically resize themselves if the 
application window is made larger or smaller.  However, if you 
manually resize any columns in the Frame Tracker window, column 
widths become static.  Thereafter, if you resize the application 
window, the Frame Tracker columns will not adjust automatically.  
Reset Column Widths re-enables this automatic resizing 
capability.

Docking and Undocking the Window
You can undock the Frame Tracker window by double-clicking on the blue 
title bar along the left side of the window.  Once undocked, the window can 
be dragged anywhere in the application.  To redock, double-click again on 
the title bar.

Full Screen Zoom In

Synchronize Trace View.  
Synchronizes the Trace View and 
Frame Tracker windows so that a 
move in one window repositions the 
other.

Zoom Out

View Options.  Opens a menu with 
three options:  Collapsible Idle Time, 
Tooltip Display, and Reset Column 
Widths. See View Options Menu 
below for descriptions.
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Calculating Time between Frames
In Frame Tracker, you can calculate time between Frames by clicking on an 
event and then positioning your mouse pointer over a second event and 
reading the ensuing tooltip.

Step 1 Click on the time value for the first event.   

Step 2 Scroll down through the trace to the second event and position the 
mouse pointer above its time value.  A tooltip will appear showing 
the time interval between the first and second events.  

Hiding Traffic
You can hide Aligns, Channels and other data from the Frame Tracker 
window by clicking the Hide buttons on the toolbar in the Trace window 

 or by selecting one or more of the various Hide options in 
the Display Options dialog box. 

Searching
When the Trace view and Frame Tracker windows are synchronized, the 
Find and Go To options in the Search menu will apply to the Frame Tracker 
window.  The Trace and Frame Tracker windows can be synchronized by 
selecting the Synchronize button .

Zooming In and Out
Zooming out can give you a quick, high-level view of a trace.  
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8.  Searching Traces
SATracer has several search commands that enable you to navigate a trace 
in search of key events such as errors and triggers.  These commands are 
launched from the Search menu.

To view the search options, click Search in the Menu bar.

8.1  Go to Trigger
To display a Trigger Event, select Go to Trigger from the Search menu.

The Trace View is repositioned with the first Frame following the Trigger 
event (or the Frame that caused the Trigger) at the top of your screen.

8.2  Go to Event ...
To display a specific Frame or higher decode level, follow these steps:

Step 1 From the Search menu, select Go to Event ... 

The Go to Event window appears.
Step 2 From the Go To pull-down menus, 

select Frame, Time, or Markers (if 
present).

If you select Frame, a menu of decode 
levels will appear.  Select the decode 
level of interest (if it does not appear, you may have to press a 
decode button on the toolbar).  Then enter an event number in the 
text box to the right.
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If you select Time, a text box will appear prompting you to enter a 
time value.

If you select Marker, a list of Markers in the trace will appear.  Select 
a Marker from the list.

Step 3 Click OK.

The trace view is repositioned with the selected item at the top of 
your screen.

8.3  Go to Marker
To instruct the Analyzer to display a marked Frame, follow these steps:

Step 1 From the Search menu, select Go to Marker.

Step 2 Select the desired Frame from the displayed list.  

The Trace View is repositioned with the selected item at the top of 
your screen.
Selecting Search > Go to Marker > All Markers will cause a 
dialog box to open with a list of all markers in the trace.  The dialog 
box offers options for editing, deleting, and copying markers.

Note The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses 
following each marked Frame are added or edited with the Set 
Marker feature. Please refer to Set Marker in Reading a 
CATC Trace.
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8.4  Go To
The Go To feature takes you directly to an event in a Trace by allowing you 
to search by a specific criteria. Only the items present in a trace will be 
displayed in the Go to menu. If an item is not present in a trace, it is greyed 
out in the menu.  

To apply the previous Find parameters to the next search, select Find Next 
from the Search menu. 

8.5  Find
Find is a utility for conducting searches of one or more events within a 
trace. Find allows you to search different hierarchical levels within the trace 
- Frames, Transactions, SCSI Operations, and Mgt Transactions.  To start 
find,

• Select Find... under Search on the Menu Bar

OR

Click  in the Tool Bar.
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You see the User-Defined Find Events screen:

The Find window divides into three areas: 

Left area --  Display options for setting the search level, direction and 
origin.   The top left box is context-sensitive. In order for the Transactions, 
SCSI Operations, and Management Transactions to be active, you will 
need to decode these levels in the trace. 

The left area includes two options at the bottom:

• Find All - Finds all specified events and extracts the results to a 
new window.

• Search in Hidden - Searches for specified events in all of the 
trace - including in traffic currently hidden from the display via 
the Hide buttons.

Center area  -- Controls the event groups to be searched. The selection you 
make will display further choices on the right side of the Find window. At 
the bottom are three options called Union, Intersection, and Exclusion that 
are used with multi-criteria searches. These options are explained below.

Right area -- Controls the specific events to be searched within the trace. 
The box in this right section displays events from the selected Event Group. 
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The right area is context sensitive - the Event Group selected in the Center 
Area determines what types of events display on the right. For example, if 
"Primitive Type" is selected, the right area will display a list of Primitive 
types. Bold entries indicate items that actually occurred in the trace.

In the example shown above, Primitive Types is selected. The right side of 
the screen shows all of the Primitive Types that occurred in the displayed 
trace.

Complex Searches
When conducting complex searches in the Find 
dialog box, you first push a decode button in the 
toolbar to enable Frames, Transactions, SCSI 
Operations, or Management Transactions in the 
Search for... box.

In this example, all of the Search for choices are 
enabled, and Frames is selected.  The Event Groups box in the Find dialog 
contains available choices based on the selection. 

After you have selected a choice in the Event 
Groups, the box on the right of the Find 
window will present choices based on your 
selection. In the following example, the box 
displays the primitive types that are available 
in the trace:

Event Groups
Event Groups are categories of events that can 
occur in a trace. Clicking on an Event Group 
will display a list of Event types on the right 
side of the Find window that occur within each 
Event Group.

Union, Intersection, and Exclusion
If multiple events are selected, use the options Union or Intersection to 
conduct the search. 

Union is used to search for any selected event: "Find x or y." Union lets you 
tell the Analyzer to search the trace for any of any of the selected items.    

Intersection is used to search for all selected events: "Find x and y." 
Intersection lets you tell the Analyzer to search the trace for any packet 
having all of the selected events.
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Exclusion is used to exclude selected traffic from the trace. Exclusion is 
used with Union and Intersection --i.e., you select Exclusion with Union or 
Intersection. 

• Exclusion + Union -- Exclude packets with any of the specified events. 

• Exclusion + Intersection -- Exclude packets with all of the specified events. 

Using Find
Step 1 Select the display level to be searched from the Search For box on 

the left side of the window. 

For example, to search through Commands, select Commands. The 
display level affects options presented in the Events Group box.

Step 2 Select a search direction and origin.

Step 3 Select one or more events from the Events Group box.

Your choices will affect options displayed on the right side of the 
dialog.

Step 4 If you have selected two or more criteria, then select either:
• Union: Find all packets that match ANY of the specified events. 

• Intersection: Find all packets that match ALL of the specified events.   

If you want to selected events from the trace, then select:
• Exclusion: Exclude all packets that match any of the specified events.   

Step 5 Click OK.  The search then occurs, and the results display.

Find Next
To apply the previous Find parameters to the next search,

Select Find Next under Search on the Menu Bar

OR

Click  on the Tool Bar.

When Link Tracker is open and Find Next  is used, the software repositions 
the LinkTracker (and other views) on the next frame containing the same 
primitive. For example, when using Find Next to search for SATA_SYNC 
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primitives - the display will select the next primitive in time starting from 
the specified origin (top of the screen, beginning of the file, last match), 
regardless of which frame and which recording channel it occurred.

When using Find Next for primitives, the search order will be as shown
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9.  External Interface for Trigger In /Out 
With each 10K analyzer, LeCroy includes two mechanisms for low latency 
communications with general purpose test and measurement equipment:

• BNC Trigger in / out - This connection can be used to send 
clocking information and recording commands from one analyzer 
to another (see "Setup for Cascaded Muliple Analyzer Use in 
Section 10.3).  The BNC interface can also be used for transmitting 
and receiving trigger in / out signals from general purpose 
instruments such as a LeCroy Oscilloscope or an InFusion Error 
Injection system. 

• Break out board  -  The break-out board utilizes a LV TTL level 
signal which can provide a simple trigger in/out interface to the 
analyzer.  It can also be used to configure the analyzer to trigger on 
a specific bit pattern received on the break out board data pins.

9.1  BNC External Trigger In / Out
The BNC External Trigger Out capability allows users to specify protocol 
level events as Trigger Out signals to external instruments. This provides a 
mechanism for SAS or SATA link layer errors detected on the analyzer to 
trigger an attached oscilloscope. The BNC Trigger In provides a similar 
mechanism allowing physical layer instruments to signal the analyzer to 
start capture at a specific instant. 

Using the BNC Trigger Out

Step 1 Attach the BNC Trigger Out connector to an appropriate BNC 
Trigger In connector on a general purpose test instrument using the 
provided BNC cable

Step 2 In the SATracer software, under Recording Options, select the 
Recording Rules Tab

Step 3 Select the New Event button and specify the protocol level event 
desired to initiate the external Trigger Out signal
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Step 4 Under the Actions Tab, Select the type of External Trigger signal 
suitable for the external instrument. The 10K chassis support three 
external trigger-out signal types:

• Pulse High 

• Pulse Low 

• Pulse Toggle

Note: In each case, the BNC signal transmits an LV TTL level signal 

Step 5 Select Trigger Analyzer on the Actions Tab if you intend to record 
protocol level traffic simultaneously while using the BNC External 
Trigger Out signal

Step 6 Press the Record button to arm the analyzer. Trigger indicator on 
the analyzer faceplate will indicate when the trigger condition has 
been detected by the analyzer system.

Using the BNC Trigger In

Step 1 Attach an appropriate BNC Trigger Out connector on a general 
purpose test instrument to the BNC Trigger In connector using the 
provided BNC cable.
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Step 2 In the SATracer software, under Recording Options, select the 
General  Tab and click the radio button Event Trigger under 

Recording Type

Step 3 Select the Recording Rules Tab. Remove all triggering events from 
the Recording rules (Filtering options can be retained - see 
Recording Rules screen image below)

Step 4 Press  Record > Start button to arm the analyzer. The analyzer will 
indicate it is waiting for a trigger. Any edge detected on the Trigger 
In signal will stop the recording and fill the buffer on the analyzer.

Note: Voltage required on the edge condition is 0 to.8V low, 2.0V to 3.3V high. 40nS is 
the approximate detection threshold for the BNC Trigger In feature.

Note: There is also a trigger indicator on the analyzer front panel that will indicate when 
the trigger condition has been detected by the analyzer. 
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9.2  External Interface Breakout Board
With each analyzer, LeCroy includes an External Interface Breakout Board 
for accessing several potentially useful standard, LV TTL output and input 
signals. The breakout board also offers a simple way to connect logic 
analyzers or other tools to the SATracer Analyzer unit. Six ground pins and 
one 5-volt pin are provided.

The Breakout Board connects via a 
cable to the Data In/Out connector 
located on the rear of the analyzer 
unit. Each signaling pin is isolated by 
a 100Ω series resistor and a buffer 
inside the Analyzer unit. 

9.3  Pin-Outs for the Data In/Out Connector
The following table lists the pin-out and signal descriptions for the Data 
In/Out connector on a cable that connects to the Breakout board.   
Data In/Out Connector – Pin-Out

Pin Signal Name Signal  Description
1 RSV Reserved
2 GND Ground
3 GP OUT General Purpose Output
4 TRG IN 1 Trigger In 1
5 GND Ground
6 DATA 6 Data 6
7 DATA 4 Data 4
8 DATA 3 Data 3
9 DATA 1 Data 1
10 GND Ground
11 RSV Reserved
12 RSV Reserved
13 +5V +5 Volts, 250 mA DC Source
14 RSV Reserved
15 GND Ground
16 TRG OUT Trigger Out
17 TRG IN 0 Trigger In 0
18 DATA 7 Data 7
19 DATA 5 Data 5
20 GND Ground
21 DATA 2 Data 2
22 DATA 0 Data 0

Data In/Out Connector (on cable)
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Note: (*) Pins 4 and 17 have the same function: they allow external 
signals to be used to cause triggering or recording. Pins 3 and 16 
are used to transmit output signals. Pins 6, 7, 8, 9, 18, 19, 21, and 
22 (data pins) are used to define data patterns for external input 
signals. See External Input Signals in Chapter 6. 

External Interface Breakout Board

Prototype Rework Area
The Breakout Board contains a prototype rework area for making custom 
circuits for rapid development. The area consists of plated-through holes, 20 
columns wide by 27 rows long. The top row of holes is connected to GND 
and the bottom row is connected to +5V. The remaining holes are not 
connected. Use the rework area to insert custom components and wire-wrap 
their respective signal, power, and ground pins. 

23 GND Ground
24 RSV Reserved
25 RSV Reserved

Pin Signal Name Signal  Description
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9.4  Configuring Input Signaling through the Breakout 
Board
To configure the analyzer to trigger on an input signal from the breakout 
board, perform the following steps: 

Step 1 Select Setup > Recording Rules to open the Recording Options 
dialog.  The Recording Rules page will display. 

Step 2 Click the New Events button to open the New Events menu.

Step 3 Select Breakout Board Data from the New Events menu.  This will 
cause a button to appear in the Available Events area.  The button 
will be labeled Breakout Board.

Step 4 Drag the new button to the Global State Cell or to the cell faintly 
marked Drag an event here to add another state.  The Global 
State Cell allows you to set conditions that are globally true (i.e., 
always enabled).  The cell marked Drag an event here to add 
another state is used to create event sequences - i.e., chains of 
events leading to a trigger or other action.  For further explanation, 
see “Assigning an Action” on page 46.

Step 5 Right-click on the Breakout Board button to open a pop-up menu.

Step 6 Select Properties from the pop-up menu.  The Properties dialog 
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opens.  

Step 7 If you want to configure the analyzer to trigger on a specific bit 
pattern, enter it in the box marked Byte0.  Alternatively, you can 
enter a hex pattern and mask into the boxes marked Mask and 
Match.  If no pattern is specified, the analyzer will trigger on ANY 
input signal.

Step 8 Click the tab marked Actions.  

Step 9 In the Internal Triggering section, select Trigger Analyzer.  The 
analyzer is now configured to trigger on an input signal.
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10.  Networking SATracer 

SATracer has networking and cascading functions that are described in this 
chapter.   

• Cascading -- Allows two to four analyzers be linked (or "cascaded") 
together into a single, synchronized, logical unit in order to increase the 
number of ports that can be monitored.  To enable synchronized 
multi-analyzer recording, the analyzers are connected together via their 
BNC connectors on the back of the analyzers.  This connection is used 
to send clocking information and recording commands are sent from one 
analyzer to another.

• Networking -- SATracer can be run remotely over an IP LAN.  Using 
the Network browse dialog, you can remotely control one or more 
analyzers. 

10.1  Working with Multiple Analyzers
Multiple SATracer analyzers can be set up in three ways:

Directly Connected by USB - Two or more analyzers can be connected to 
a single host PC via USB.  In this setup, no additional cables are used (as 
they are in a Cascaded setup) and the analyzers function as  non-cascaded, 
standalone units.  Users toggle back and forth between the units.

Cascaded - Two or more local analyzers linked by BNC.  One (or all) of the 
analyzers then connect via USB to a host PC.  

The BNC cable functions to transmit clocking and control information 
between the analyzers, thereby allowing the analyzers to function as a 
cascade - i.e., a single, logical analyzer. Cascading  analyzers allows them 
to perform synchronized, multi-analyzer recordings.  

Connected Remotely over an IP Network - A PC connected to analyzers 
across an IP network.   
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10.2  Hardware Setup for Direct USB Connections
Connecting multiple analyzers to a single PC by USB gives you the 
convenience of being able to control multiple analyzers from a single 
SATracer application. The application provides you with a means of 
toggling back and forth between the analyzers.

To set up multiple analyzers via 
USB, you attach USB cables 
between the analyzers and the host 
PC as shown in the illustration on 
the right.  If you do not intend to 
group the analyzers together for 
synchronized multi-analyzer recordings, no further hardware setup is 
required.  If you do intend to group the analyzers, then you will need to add 
BNC cables as described in the section below under "Setup for Multiple 
Analyzer Use."  Once the analyzers are connected and started, you can 
browse to the analyzers via the command Setup > Analyzer Network ...

Note The SATracer software will allow you to toggle between the 
analyzers but not run two copies of SATracer software on your 
screen simultaneously.

10.3  Setup for Cascaded Multiple Analyzer Use 
If you add a BNC connection 
between the analyzers shown 
above, you create a cascade which 
allows the analyzers to function 
together as a logical unit. 
Cascading increases the numbers 
of ports that can be simultaneously recorded.  

To set up a cascade, you connect a BNC cable between 
the External Output port on the back of one analyzer to 
the input port on the second.  The first analyzer will 
serve as the controlling or master analyzer.  It will 
transmit clocking information, Recording Option 
commands and other data to the other analyzers.  If you 
plan to group three or four analyzers together, 
daisy-chain the remaining analyzers together, and then 
loop the output of the last analyzer to the input of the 
first analyzer as shown in the figure on the right. 
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10.4  Set Up for Remote Access over an IP LAN
SATracers can be run 
remotely over an IP 
network.  In an IP 
network, the analyzers 
connect their respective 
hosts via USB and the 
hosts, in turn, connect to each other via IP.  

Setup involves installing SATracer software on each analyzer host, then 
enabling IP LAN connectivity between the hosts.  

When the remote analyzer is powered on, you connect remotely control the 
analyzer via its host.  Your connection will be Local host => Remote host 
=> Analyzer.  

Use the command Setup > Analyzer Network to browse to the remote host.

You can cascade IP-connected analyzers by adding BNC connections 
between the analyzers as described above in “Setup for Cascaded Multiple 
Analyzer Use” on page 126.  

10.5  Configuring the Connection
Once you have completed the physical setup, you are ready to configure the 
analyzer connection.  

USB-Connected Analyzers
Configuration for two or more USB connected analyzers is minimal.

In the following example, two analyzers are linked via USB to a host PC.  
You connect to one of the two analyzers.

Step 1 Start the SATracer analyzers and the SATracer software.

Step 2 From the menu, select Setup > All Connected Devices.  

The Analyzer Network dialog box opens.  To select an analyzer, 
check the relevant checkbox on the left.   
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Step 3 Click Close.  

The dialog box closes and the analyzer is selected.  The SATracer 
software on your screen will now control the selected analyzer.

Note You can update the Firmware, BusEngine and License from this 
dialog by checking an analyzer and then clicking the appropriate 
button on the right.  You can also directly open and set 
Recording Options for any of the analyzers by checking one or 
more analyzers and then clicking the Recording Options button.  
The Recording Options dialog will open.  The settings you create 
will apply to all selected analyzers.

Remote Analyzers Over an IP Network
To configure SATracer to remotely control an analyzer over an IP LAN, 
you will need to use the Analyzer Network dialog to browse to the host 
controlling the analyzer and add both the host and its PC to the dialog.

Step 1 From the menu, select Setup > Analyzer Network.  

The Analyzer Network dialog box opens.  This dialog lists host PCs 
and their analyzers.  The listed devices are either currently connected 
or were connected at some point previously.   

Step 2 Remove any host (other than the Local Machine) from the list by 
selecting the host and then clicking Remove.

You should keep in the list only the host(s) that you are planning to 
immediately use.

Step 3 To add a host and analyzer to the list, click Add.  
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A browse dialog box opens.  

Step 4 Browse to the host that has an analyzer attached to it and double 
click on it.  

Step 5 The host will be added to the Analyzer Network dialog.

Step 6 Click Close to close the dialog box.

Step 7 Select Setup > All Connected Devices ... to open the Analyzer 
Devices dialog box.  

Step 8 Uncheck all boxes except for the one for the remote analyzer that 
you wish to connect to.

Step 9 Click Close to close the dialog box and establish a connection to the 
selected analyzer.

Configuring Cascaded Multiple Analyzers
To configure analyzers to work as a group (i.e., into a cascade), attach BNC 
cables as described “Setup for Cascaded Multiple Analyzer Use” on page 
126, then perform the following steps:

Step 1 Perform Steps 1 and 2 as described above in “USB-Connected 
Analyzers” on page 127.

The Analyzer Devices dialog box will open.

Step 2 In the Analyzer Devices dialog box, verify that the checkboxes are 
checked for the cascaded analyzers.

Step 3 Click Close.

The dialog closes and the analyzers are selected.
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Step 4 Test the setup by recording some traffic.  

If the analyzers are not connected by the BNC cables, an error 
message will appear prompting you to correct the problem.

10.6  Network Chat
Analyzer Network Chat is a utility that allows users to conduct chat 
sessions over an IP LAN.  

In order to send and receive electronic text messages, each user must be 
working with a PC that is attached to an analyzer.  And each PC must, in 
turn, be connected to an IP LAN. 

To start a chat session, 

Step 1 Select View > Analyzer Network Chat Bar from the menu.  The 
following dialog opens. 

Step 2 Click in  the cell at the bottom of the window and type some text.

Step 3 Click Send.  The sent text will appear in the top of the window next 
to your prompt. 
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11.  Traffic Generation with SATrainer
SATrainer is traffic generation software that runs on the SAS/SATA 
Exerciser hardware module.  SATrainer can emulate a SATA host or 
device.

Traffic generation enables engineers to test designs under realistic 
conditions and to transmit known errors, allowing engineers to observe how 
devices handle faulty link conditions.

Traffic generation is performed via the execution of text-based scripts.  
These scripts contain statements about the types of traffic to be generated.  

11.1  SAS/SATA Exerciser Hardware
The SATrainer software requires both the SAS/SATA Analyzer module 
and the SAS/SATA Exerciser module that plugs into the right slot of the 
UPAS 10K. 

11.2  Cabling SAS/SATA Exerciser for Host Emula-
tion

Connect the SATA cable from 
the SAS/SATA Exerciser To 
Target port to the Device port 
on the unit under test. This 
transmits the Traffic 
Generator stream from the To 
Target port on the SAS/SATA 
Exerciser to the Device-side 
port on the unit under test.
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11.3  Cabling SAS/SATA Exerciser for Device Emula-
tion

Connect the SATA cable from 
the SAS/SATA Exerciser To 
Initiator port to the Host-side 
port on the unit under test. This 
transmits the Traffic Generator 
stream from the To Initiator 
port on the SAS/SATA 
Exerciser to the Host-side port 
on the unit under test.

11.4  Generating Traffic
Generating traffic using the SATrainer is a two step process. First, 
text-based Traffic Generator file must be created. This file can be created 
through a special conversion command in SATracer that converts a trace 
file into a traffic generator file. Alternatively, you can edit an existing file 
or write your own. 

This text file is named with an .ssg extension. Once the file has been created, 
in can be opened and displayed in the SASTracer application. You can 
invoke the  SASTracer application to transmit the traffic generation file by 
using the Traffic Signal button . 

Creating a Traffic Generation File with SASTracer
The easiest way to create a Traffic Generation file is to convert an SATracer 
trace file (*.sas) into a *.ssg file. This is done with the Export function in 
SATracer.

Step 1 Open a trace file.

Step 2 From the menu, select File>Export>to Generator File Format 
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(.ssg). The Export to Generator Text screen appears.

There are several options:

File Name - Enter a user-defined file name.

Save As Type - There is but one option:  SASTrainer Generator 
Files (.ssg).  This file type is used by both SASTrainer and 
SATrainer to generate traffic.

Link and Direction - Select the source and direction of the traffic 
you are going to export into a traffic generation file.  You can only 
export a single uni-directional link (for example, I1).

Do not export hidden packets - If selected, will only export traffic 
that is currently displayed onscreen.  Traffic hidden via the various 
hide buttons will not be exported into the traffic generation file.

Use Auto Alignment - If selected, exports Auto Aligns to the traffic 
generation file.

From - (Optional) Enter the range of traffic (in Frames, Markers, or 
Time) to be exported.  The default is to export all traffic in the open 
trace.

Step 3 Select the desired options, the click Save.

A  Generator file (*.ssg) has now been created and can be read with the 
SATracer/Trainer application. 
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11.5  Opening a Traffic Generation File
Once the Traffic Generation file (*.ssg) file has been created, you can then 
open it in the SATracer application.

To open a Traffic Generation file,

Step 1 Select Open under File on the Menu Bar

OR

Click  on the Tool Bar. 

Step 2 Select a Generator text file (*.ssg) and click Open. If needed, 
navigate to the install directory. For samples, see the install 
directory. The Generator file appears in a Trace view, shown 
below:

Layout
The .ssg file will show several colored bars across the screen that represent  
global settings.  The bars serve to show how the generation file is currently 
configured.  These settings include the link speed (1.5 Gbps vs. 3.0 Gbps), 
the type of device (SATA Host or Device), COMINIT, COMWAKE and 
some other settings.  As changes are made and saved to the traffic generation 
file, the bars will immediately update.  
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The actual traffic pattern that is about to be generated appears below the bars 
as a series of Frames.  In the generation file shown in the above screenshot, 
the first generation Frame is a Start of Address Frame labeled as Frame 8.

You can edit the traffic generation file to add, edit or remove frames.

11.6  Starting the Script Editor
To edit an .ssg file, use the Script Editor.  The Script Edit is an editing tool 
that will display the .ssg file and its supporting Include files.

To launch the Script Editor:  click the Script Editor button on the toolbar 
 or right-click in the trace window and choose Edit as Text.

The Script Editor window will open and display in the lower portion of the 
trace window.  

The Script Editor divides into three areas:  the toolbar, the script window, 
and the file tabs at the bottom of the window.  If errors occur, a log will open 
at the bottom of the window.
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Toolbar
The toolbar contains buttons for saving your edits, navigating, searching 
and other functions. 

The buttons have the following functions:

View Options  Menu 
The View Options button has a menu with three options: 

• Enable Outlining - Adds an expandable/collapsible 
tree structure to the left side of the Script Editor 
showing the hierarchical relationship of the script lines.

• Show Line Numbers - Adds line numbers to the left 
side of the Script Editor window.

• Show Tooltips - Displays tooltips in the editor window.

• Toggle Outlining - Toggles the outline tree between collapsed and 
expanded states.

Save.  Saves your edits and 
immediately updates the setting bars 
and Frames shown in the trace 
window.

Go to next bookmark.

View Options.  Opens a menu with 
three options:  Enable Outlining, 
Toggle Outlining, and Line Numbers. 
See View Options Menu below for 
descriptions.

Go to previous  bookmark.

Cut. Clear all bookmarks.

Copy. Find.

Paste. Find and Replace.

Undo. Print.

Redo. Go to Definition.

Add/Remove bookmark.  Allows 
markers to be set or removed to aid in 
navigation.

Open File Under Cursor.  Opens 
whatever file has been pointed to 
with the mouse in the script.  
This command works with 
Include statements.
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Pop-up Menu 
Right click anywhere in the 
script window to open a 
pop-up menu with the 
following options:  

Cut - Cuts selected text.

Copy - Copies selected text.

Paste - Pastes selected text.

Go to Definition of - Repositions the script window to whatever definition 
has been selected.

Open File - Opens whatever file has been pointed to with the mouse in the 
script.  This command works with Include statements - for example, 
"%include "Generation\Include\PrimitivesDecl.inc".

Close File - Closes whatever script file is currently being displayed.

Enable Outlining, Toggle Outlining, and Line Numbers - Enables the 
three options described above under View Options Menu.

File Tabs
At the bottom of the window are a series of tabs that allow the .ssg file and 
its supporting Include files to be opened and edited.  The Include files open 
automatically when the software first reads the script. 

Error Log
Whenever you create a scripting error, a log will open at the bottom of the 
application window.  When the error is corrected, the window automatically 
closes. 
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11.7  Overview of Generation & Global Settings Files  
Sample .ssg files and Include files reside in two 
directories called  \Samples and \Include that are 
typically installed  in:
C:\Program Files\CATC\SATracer\Generation.

Traffic Generation (*.ssg) Files
The .ssg traffic generation files are text files consisting of include 
statements, a generation block and, optionally, global statements.  

The generation block is the code responsible for the actual traffic 
generation.  It is marked by the tag "Generation."  The composition and 
format of the generation block is described later.  

The include statements provide links to the Include files which, in turn, 
provide the definitions for primitives, frames, and "global settings" - i.e., 
settings that hold for most or all of the generation session.  

The definitions for SAS and SATA traffic are contained in 
LeCroy-provided Include files:  Settings.inc, PrimitivesDecl.inc, 
AddressFramesDecl.inc, SSPFrames.inc, SMPFrames.inc and 
SSPFrames.inc.

Settings.inc File
The Settings.inc file contains global statements about the link, the type of 
device being emulated, and other conditions that are to exist throughout part 
or all of the traffic generation. This file must be included in the traffic 
generation file.  

There are fifteen groups of settings in this file:  

• AutoMode

• COMINIT/COMRESET OOB Signal

• COMWAKE OOB Signal

• COMSAS OOB Signal

• Generation Commands
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• Link Speed

• SATA Link Initialization

• SAS Speed Negotiation

• SATA Speed Negotiation

• Autowait:

• SAS After

• SAS Before

• SATA After

• SATA Before

• Wait Command Timeout

• Scrambling Mode

Details about each group of settings are described in the following chapter 
Traffic Generation Language.

Editing Settings.inc
Text in the Settings.inc file can be edited directly or copied into the 
beginning of the traffic generation file and edited there.  Many users opt for 
this latter approach.  

When editing global settings, keep in mind the following rule:  

• The last line encountered before the generation block takes 
precedence.  Thus, if the following two lines about the device 
emulation were added just above the generation block, the second 
would take effect:

set GenerationMode = GEN_MODE_SATA_HOST

set GenerationMode = GEN_MODE_SATA_DEVICE
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The Global Setting "AutoAlign"
AutoAlign is a global setting that may be on or off depending on the type of 
device you are emulating.  There is an AutoAlign setting for SAS and one 
for SATA - for example, "set AutoAlignSAS = ON" and "set 
AutoAlignSATA=OFF."

SAS - Sends AutoAligns every 2048 dwords.

SATA - Sends AutoAligns every 256 dwords.

If you plan to set and reset AutoAlign in the middle of traffic generation, 
then you need to know what the defaults are for AutoAlign.  The defaults 
are as follows:  

For SATA host/device emulation, then 

• AutoAlignSATA is assumed to be ON

• AutoAlignSAS is assumed to be OFF.

For SAS emulation, then the assumptions are opposite:

• AutoAlignSATA is assumed to be OFF

• AutoAlignSAS is assumed to be ON

For STP, 

• AutoAlignSAS and AutoAlignSATA are assumed to be ON
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Placing Global Settings in the Generation Block
Some global settings such as AutoAlign = On/Off can be set and reset in the 
generation block.  For example, a user might want to set SASAutoAlign = 
ON prior to traffic generation and then have it change to OFF half way 
through the generation session.  

When placed within the generation block and then viewed in the trace 
window, global settings appear as colored bars interspersed amidst the 
traffic.  
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While most global settings can be set in the generation block, three will be 
ignored if placed within the generation block:

set Link Speed =

set GenerationMode =

set SSC = 

These commands should be configured either in the Setting.inc file or at the 
beginning of the traffic generation file as a global statement.

11.8  Primitive and Frame Definitions
Five other Include files are provided that define the most of the known 
templates for Primitives and Frames.  The five are: 

• PrimitivesDecl.inc

• AddressFramesDecl.inc

• SSPFramesDecl.inc

• SMPFramesDecl.inc

• STPFramesDecl.inc.  

Each of the Frame templates defines header and field structure.  

The default value for all Frame fields is zero. 

Special Conditions for Frames
There are three conditions about Frames that need to be kept in mind when 
configuring Frame generation:

1.  Frame delimiters need to agree -  At the present time, when defining a 
Frame, make sure that the Frame Prologue and Frame Epilogue agree.  Do 
not mix types.  For example, do not mix a SAS Start of Frame (SOF) with a 
SAS End of Address Frame (EOAF).  

A SAS SOF should be matched to a SAS EOF, a SAS SOAF should be 
matched to a SAS EOAF.  If generating SATA traffic, a SATA_SOF should 
be matched to a SATA_EOF.

At the present time, if you mix different types of prologues and epilogues 
for any given Frame, the Frame will be ignored.  
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2.   Data Length Fields can be fixed-length or variable - By default, data 
Frames are of a fixed length.  If you want to generate variable length 
Frames, then place an asterisk in the Data definition field in the 
SSPFramesDecl.inc file:  
Data   : * 

If you replace the asterisk with a value, then the field becomes fixed length.

3.  CRC Calculations will be calculated by SATrainer unless told 
otherwise - If the CRC is not explicitly set in the traffic generation file, 
SATrainer will assume that you want it and will calculate and display it in 
front of the generated Frames.  

If the user provides a CRC value, SATrainer will use that value even if it is 
incorrect.  This gives the user the option of configuring the generator to  
create errors.

If the generation file was created through the Export command (i.e., File > 
Export > To Generator File Format ...), the CRC is calculated but 
commented out.  If the source trace has a bad CRC, the CRC is exported into 
the generation file and is not commented out.

PrimitivesDecl.inc
The PrimitivesDecl.inc file defines Primitives.  The file consists of a 
declarations (left) and the corresponding byte stream (right).  

To generate Primitives, copy relevant portions of text on the left (i.e., not the 
bytes shown right) from this file into the generator block section of the .ssg 
file.  

For examples of usage, see primitives.ssg in the Samples directory.

AddressFramesDecl.inc
The AddressFramesDecl.inc file defines Address Frames. 

For examples of usage, see AddressFrames.ssg in the Samples directory.
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SSPFrames.inc
The SSPFrames.inc file defines SSP Frames.

For examples of usage, see SSPFrames.ssg in the Samples directory.

SMPFrames.inc
The SMPFrames.inc file defines SMP frames

For examples of usage, see SMPFrames.ssg in the Samples directory.

STPFrames.inc
The STPFrames.inc file defines STP frames

For examples of usage, see STPFrames.ssg in the Samples directory.

11.9  Working with Generation Files
The easiest way to generate traffic is to start with one of the sample 
generation files and edit the settings to see how the script file behaves.  As 
you make and save changes, the trace view of the generation file is 
automatically updated.  
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The following screenshots shows the sample file SSPFrames.ssg as it 
appears in the script editor and trace window.

In the lower screenshot, global settings make up the eight bars at the top of 
the window.  Below that are five frames.  If you look at the script itself, you 
will see that there are six frame commands, five active and one commented 
out.
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11.10  Generating Traffic
Once the .ssg file has been opened onscreen, recording and traffic 
generation can begin at any time.  

Step 1 Click  to begin the recording.

Step 2 If the script does not have a connect block built into it, connect 
the exerciser to the DUT by clicking the Connect Link button 

. Clicking this button will cause the generator to invoke the 
various settings in your script (for example, the global settings) 
and then establish a connection.

Step 3 Click the Start Generation button   on the Tool Bar. 

While generating traffic, a bar appears on the right of the trace view, 
indicating that traffic generation is taking place (The green light on the 
Traffic signal button also blinks during traffic generation).

Stop Traffic Generation
Normally, traffic generation stops automatically when SATrainer reaches 
the end of the Generator file. 

To manually stop traffic generation, Click the Stop Generation button  .

Resume Traffic Generation
If traffic generation is stopped prior to the end of the script, it can be 
resumed. 

To resume traffic generation, Click the Stop Generation button  .
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12.  SASTrainer Generation Language
The SASTrainer File Generation Language is an API that allows you to 
separate traffic into text commands. These commands are used construct 
primitives and frames that are sent to the host or the device. 

12.1  File Structure
Traffic Generation files (*.ssg) should have the following structure:

Declarations
• Global generation settings   
• Constants
• Data patterns
• Chain of symbols (primitives, raw data, etc)
• Packet templates

Note Some declared objects could be used in further declarations as long 
as they are previously declared. No forward declarations are allowed 
at this time.

Generation blocks 
• List of generation instructions

Note It is possible to create many generation blocks - but at current time 
only a block with the name 'Generation' will be executed. (Calls of 
some blocks from another blocks are not currently allowed)

12.2  Language

Comments: 
'#' - Comment symbol. The line remainder after this symbol will be ignored.

'/*' '*/' - Comment Block. All the text between '/' '*' and '*' '/' is ignored.

/*

    This is an example of a block of comments. 

*/
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Includes:
%include "FileName.inc" - This directive includes the file "FileName.inc". 
This lets the user add common definitions and templates into new scripts.

Language parser makes sure the same file is not included more than once.

Example:
%include "SomeInc.inc"   # This directive will actually include file 
'SomeInc_1.inc'

%inline - The same as %include, but without the Language parser check.

Settings
Using the "Set "Constant Name" = Value" statement, users can set different 
constants/modes using the following value types:

• Predefined constants (TRUE/FALSE/ON/OFF/INFINITE/etc)
• Numbers

Examples:
Set AutoAlignSATA=ON

Set WaitTimeOut=239

Constants
Only unsigned integers can be defined as constants. Some constants are 
predefined in SASTrainer

Examples:
Const SOME_HEX_DATA   = 0xAABBFFEE # defines hexadecimal 
constant 
Const SOME_DEC_DATA   = 12     # defines decimal constant
Const "SOME DEC DATA" = 64     # defines decimal constant
Const "Some Hex Data" = 0xCDCDBEBE

Predefined Constants
• TRUE
• FALSE
• ON
• OFF
• INFINITE
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Data Patterns
Data patterns are streams of hexadecimal values. Using '['']' lets the user 
include constants or predefined data pattern in another pattern. 

Examples:
DataPattern PATTERN_1 = AAAABBBB [SOME_HEX_DATA] 
EEEEFFFF   1210ABB1 AAAABBBB 1210ABB1  AAAABBBB 
1210ABB1 AAAABBBB 1210ABB1 ["SOME DEC DATA"] 1210AB
DataPattern PATTERN_2 = 00000000 11111111 22222222 33333333 
AAAABBBB 55556666 FEFEFEFE CDCDCDCD 9999BBBB 
12343434 6767676B 56BBFF                  
DataPattern PATTERN_3 = [PATTERN_1] FFFFFFFF EEEEEEEE 
[SOME_HEX_DATA]
DataPattern SOME_PATTERN = BBBBBBBB DDDDDDDD

Primitives
Primitives can be defined using the following:

• Byte values ('k' indicates control symbol). The 10b codes are calculated 
based on the current running disparity

• Primitives are completely interchangeable with SymChains.
Example:

Primitive "CHAIN (ONE)"  = kBC 1E 1E 1E kBC 1A 0F
SymChain ChainTwo = k28.5  D12.3  D10.2  D11.6
SymChain ChainThree = k28.3  3EA 25  k18 IFA
Primitive SOF = kBC 18 E4 67 
Primitive EOF = kBC 18 F0 9B

• Raw 10 bits codes. This definition might cause running disparity errors.
Example:

Primitive "CHAIN (TWO)"  = 305 2D4 1E4 362
• Mixed bytes and 10b codes. This definition might cause running 

disparity errors.
Example:

Primitive "CHAIN (TWO)"  = 305 2D4 1E4 362 ["CHAIN (ONE)"]

Packets/Frames
Using the "Frame" or "Packet" keyword, user can define a frame of traffic 
to be used in the generation stream. Declarations of prolog and epilog may 
be mixed with field declarations.  
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Frame "name" : "parent name"
{
Field Definition 0: "Field Name : Field Length = Default Value" 
…
Field Definition n: "Field Name : Field Length = Default Value"

Primitive Definition 0: "Primitive name, offset, count"
…
Primitive Definition m: "Primitive name, offset, count"
                      
Prolog = "primitive name"    
Epilog = "primitive name"
}   
• Field Definition

• Field length is in bits, '*' means that the length is variable and will 
be set based on the assigned value

• Field starting offset is calculated from frame start based on the 
length of the previous fields

Examples:
Field32         : 32 = 0xAABBFFEE     
FrameType   : 8  = 12
HashedDest  : 24 = HEX_DATA    
Reserved1    : 8  = 0xDA
Field16         : 16 = 0xAAAA
Reserved2    : 8  = 0xAD
CRC             : 32

• Data field Definition 
• "Data = { pattern }" - Pattern is assigned to Data
• "Data = count, value" - A pattern of "count" times "value" is 

assigned to Data
• "Data = count, start value, step" - A pattern of values starting with 

"start value" with steps of "step" and a length of "count" is assigned 
to Data

• Primitive definition. Primitives are inserted into the frame payload. 
Primitive definitions are inherited by descended frame templates 
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• Assigning '*' clears all previous settings (maybe from parent frame 
template). 

• Offset specifies the dword offset where this primitive will be 
inserted in the Frame

• Count specifies how many times to repeat the primitive 
Examples:

Primitive : *
Primitive : SOF, 48   # where 48 = offset
Primitive : "CLOSE (NORMAL)", 36, 5   # where 5 = repeat

• Prolog and Epilog define Primitive chains to be used at the 
beginning and end of the frame 

Examples:
Prolog = SOF   # For this frame primitive 'SOF' is used as a Prolog.    
Epilog = EOF   # For this frame primitive 'EOF' is used as a Epilog.

• Frames can be derived from other Frames, therefore inheriting the layout 
of the parent Frame. In this case, the user may:

• Change Prolog and Epilog
• Change default field values
• Add new fields

 

Frame Examples:

Frame  Some_Frame
{           
    Field32         : 32 = 0xAABBFFEE 
    FrameType   : 8  = 12
    HashedDest   : 24 = HEX_DATA    
    Reserved1       : 8  = 0xDA
    Field16         : 16 = 0xAAAA
    Reserved2       : 8  = 0xAD
    Data            :  * = PATTERN_1
    CRC             : 32                
            
    Primitive : *
    Primitive : SOF, 48
    Primitive : SOF, 96
 151



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
    Primitive : "CLOSE (NORMAL)", 36, 5  

    Prolog = SOF
    Epilog = EOF
}
Frame Some_Frame_1 : Some_Frame 
{           
    Field32 = "Some Hex Data"                         
    Data    = { 11111111 22222222 33333333 44444444 55555555 }
    Opcode          : 128, 8, 0x2A
    LBA             : 64
    
    Primitive : *
    Primitive : "CLOSE (NORMAL)", 24, 48 
    
    Prolog = "CHAIN (ONE)"
    Epilog = "CHAIN (ONE)"    
}

12.3  Generation Block
SASTrainer will generate the stream that is defined in this block. 

Generation
{
Chain Definition (Repeat = N, Idle = M)
Chain Definition (N, M)
Chain Definition
Frame Definition
Frame Definition (RunningDisp = ON/OFF)
Frame Definition
{
Field Definition
Data Definition
} (Repeat = N, Idle = M, RunningDisp = ON/OFF)
}

12.4  Definitions
• Chain Definition:

• Without any parameters, the chain is sent once
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• With "Repeat" and "Idle" parameters, the chain is sent N times and 
then nothing is sent (idle) M times. "Repeat" and "Idle" are 
optional.

• Frame Definition
• Without any parameters, send the frame based in default values
• With "RunningDisp" ON, send the frames based on default values 

and insert a running disparity error.
• With parameters overriding or adding to a template frame, with or 

without injection of an overriding or adding to a template frame, 
with or without injection of running disparity error.

Field Variable Declarations
You can declare a variable (var_name) as a frame of type (frame_type)

$var_name = frame_type     

Note Frame variables can be declared/re-declared and used many times.                  

Changing Frame Fields    
You can change some fields in a frame variable

 Change var_name { field_name = value }

 Preprocessor integer arithmetic
The user can declare DWORD variables, make arithmetic operations and 
use them in field and parameters assignments

Note: Arithmetic expressions are allowed only in numeric variable 
assignments.

Examples: 
Legal Operations

x = 2
    y = ( z = 12 ) + ( SOME_DEC_DATA + 36 ) / 8
    
    z = 0x1 << 5     
s = "Some Hex Data" # constant may be used in operations
    
x++
y--    
z += ( x + y )
x = ( ( y & 0xFF ) >> 5 ) / 12
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SOF ( Repeat = x, Idle = y )     
    
X
{        
        Field16 =  0xEEEE   # Example of the data payload assignment which 
uses both integer variables, constants, hex literals and data patterns                                                       
        Data    =  { y y y y 7a7a7a7a "Some Hex Data" "Some Hex Data" 
8b8b8b8b z z z z [PATTERN_3] }
}
( Repeat = 10, Idle = y )   # uses integer variable for parameter/setting

Illegal operations

     x = y + 2
SOF ( Repeat = (x+y)*7 )  # - illegal, use z = (x+y)*7   SOF ( Repeat = z ) 
instead

Loops
Loops can be used in two modes:

1. Using an integer number, loop a specified number of loops. This number has to 
be smaller than 64K.

2. Using the word "infinite", loops for ever.

Loops ( loop_count/Infinite )
{
 send instructions
 assignments
change values
send instructions
}    
        

  Example:
    LOOP( 50 )
   {
        "CHAIN (ONE)"
        "CHAIN (TWO)"        
        Some_Frame        
        $Y = Some_Frame { Data = 256, 0xFEFEFEFE }        
        Y         
        Change Y { Field32 = x }        
        Y   
        Y
    } 
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12.5  SASTrainer Generation Commands

General Commands

CLEAR_CREDIT_AVAIL  This commands clears the credit established 
with the command WF_CREDIT_AVAIL. 
(See WF_CREDIT_AVAIL in following 
section on Wait Commands for explana-
tion).  

RD_POS   Generator will insert one idle dword into 
gen stream, which will bring current RD to 
positive level  

RD_NEG   Generator will insert one idle dword into 
gen stream, which will bring current RD to 
negative level  

RD_ERROR   Generator will insert one idle dword into 
gen stream, which will bring intentionally 
break RD sequence creating RD error  

CONNECT   Generator will go through connection 
sequence using current GenFile settings 
(gen mode, speed e.t.c.) Generation will not 
resume until connection is established  

DISCONNECT   Generator will break existing connection to 
DUT  

PAUSE   Generator will come to a break and the user 
will be able to resume generation by press-
ing Resume button on Generation toolbar. 
Generator shall transmit idle dwords while 
in the Pause.  

OUTPUT_ON   Takes the Trainer out of Electric Idle state. 
If it is already out of Electric Idle, this is a 
NOP.  

OOB Commands

COMINIT   Generator will send COMINIT OOB sig-
nals using current COMINIT settings.  

COMRESET   Generator will send COMRESET OOB sig-
nals using current COMRESET settings.  
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SATA Commands
Look at STP sample file for syntax.

• SEND_SATA_FRAME
• SendSATAFrame
• SATAData
• SATA_Data
• SATACRC
• SATA_CRC
• SATAXXXX
• SATA_XXXX

COMWAKE   Generator will send COMWAKE OOB sig-
nals using current COMWAKE settings.  

COMSAS   Generator will send COMSAS OOB signals 
using current COMSAS settings.  

SATA_ALIGN   Generator will go through SATA_ALIGN 
stage of SATA SpeedNeg process using cur-
rent SATA_ALIGN settings.  

SATA_D10_2   Generator will go through SATA_D10_2 
stage of SATA SpeedNeg process using cur-
rent SATA_D10_2 settings.  

SPEED_NEG_RCDT   Generator will go through 
SPEED_NEG_RCDT stage of SAS Speed-
Neg process using current 
SPEED_NEG_RCDT settings.  

SPEED_NEG_ALIGN0   Generator will go through 
SPEED_NEG_ALIGN0 stage of SAS 
SpeedNeg process using current 
SPEED_NEG_ALIGN0 settings.  

SPEED_NEG_ALIGN1   Generator will go through 
SPEED_NEG_ALIGN1 stage of SAS 
SpeedNeg process using current 
SPEED_NEG_ALIGN1 settings.  
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Primitive Commands
The following is a list of SAS and SATA primitives declared in 
"Primitives.Decl.inc" as Symbol Chains.  If you want to use these primitives 
in your script you must also include "Primitives.Decl.inc" in your script.

• SOF
• EOF
• SOAF
• EOAF
• ALIGN (0) 
• ALIGN (1)
• ALIGN (2)
• ALIGN (3)
• NOTIFY (ENABLE SPINUP)
• NOTIFY (RESERVED 0)
• NOTIFY (RESERVED 1)
• NOTIFY (RESERVED 2)
• ACK
• NAK (CRC ERROR)
• NAK (RESERVED 0)
• NAK (RESERVED 1 
• NAK (RESERVED 2)
• CREDIT_BLOCKED
• RRDY (NORMAL)
• RRDY (RESERVED 0)
• RRDY (RESERVED 1)
• SATA_SOF
• SATA_EOF
• SATA_CONT
• SATA_DMAT
• SATA_HOLD
• SATA_HOLDA
• SATA_PMACK
• SATA_PMNAK
• SATA_PMREQ_P
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• SATA_PMREQ_S
• SATA_R_ERR
• SATA_R_IP
• SATA_R_OK
• SATA_R_RDY
• SATA_SYNC
• SATA_WTRM
• SATA_X_RDY
• SATA_ERROR
• AIP (NORMAL)
• AIP (RESERVED 0)
• AIP (RESERVED 1)
• AIP (RESERVED 2)
• AIP (RESERVED WAITING ON PARTIAL)
• AIP (WAITING ON CONNECTION)
• AIP (WAITING ON DEVICE)
• AIP (WAITING ON PARTIAL)
• BREAK
• BROADCAST (CHANGE)
• BROADCAST (RESERVED 0)
• BROADCAST (RESERVED 1)
• BROADCAST (RESERVED 2)
• BROADCAST (RESERVED 3)
• BROADCAST (RESERVED 4)
• BROADCAST (RESERVED CHANGE 0)
• BROADCAST (RESERVED CHANGE 1)
• CLOSE (CLEAR AFFILIATION)
• CLOSE (NORMAL)
• CLOSE (RESERVED 0)
• CLOSE (RESERVED 1)
• ERROR
• HARD_RESET
• OPEN_ACCEPT
• OPEN_REJECT (BAD DESTINATION)
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• OPEN_REJECT (CONNECTION RATE NOT SUPPORTED)  
• OPEN_REJECT (NO DESTINATION)
• OPEN_REJECT (PATHWAY BLOCKED)
• OPEN_REJECT (PROTOCOL NOT SUPPORTED)
• OPEN_REJECT (RESERVED ABANDON 0)
• OPEN_REJECT (RESERVED ABANDON 1)
• OPEN_REJECT (RESERVED ABANDON 2)
• OPEN_REJECT (RESERVED ABANDON 3)
• OPEN_REJECT (RESERVED CONTINUE 0)
• OPEN_REJECT (RESERVED CONTINUE 1)
• OPEN_REJECT (RESERVED INITIALIZE 0)
• OPEN_REJECT (RESERVED INITIALIZE 1)
• OPEN_REJECT (RESERVED STOP 0)
• OPEN_REJECT (RESERVED STOP 1)
• OPEN_REJECT (RETRY)
• OPEN_REJECT (STP RESOURCES BUSY)
• OPEN_REJECT (WRONG DESTINATION)
• DONE (ACK/NAK TIMEOUT)
• DONE (CREDIT TIMEOUT)
• DONE (NORMAL)
• DONE (RESERVED 0)
• DONE (RESERVED 1)
• DONE (RESERVED TIMEOUT 0)
• DONE (RESERVED TIMEOUT 1)              
• SAS Specific Script-Defined Constants

• SAS_AF_DT_NO_DEVICE_ATTACHED
• SAS_AF_DT_END_DEVICE
• SAS_AF_DT_EDGE_EXPANDER_DEVICE
• SAS_AF_DT_FANOUT_EXPANDER_DEVICE

• SAS_AF_FT_IDENTIFY
• SAS_AF_FT_OPEN
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• SAS_AF_PROTOCOL_SMP
• SAS_AF_PROTOCOL_SSP
• SAS_AF_PROTOCOL_STP
• SAS_AF_PROTOCOL_UNKNOWN

• SAS_AF_RATE_1_5_GBPS
• SAS_AF_RATE_3_GBPS

• SMP_FRAME_TYPE_REQUEST
• SMP_FRAME_TYPE_RESPONSE

• SMP_REPORT_GENERAL
• SMP_REPORT_MANUFACTURER_INFO
• SMP_DISCOVER
• SMP_REPORT_PHY_ERROR_LOG
• SMP_REPORT_PHY_SATA
• SMP_REPORT_ROUTE_INFO
• SMP_CONFIGURE_ROUTE_INFO
• SMP_PHY_CONTROL

• SSP_FRAME_TYPE_DATA
• SSP_FRAME_TYPE_XFER_RDY
• SSP_FRAME_TYPE_COMMAND
• SSP_FRAME_TYPE_RESPONSE
• SSP_FRAME_TYPE_TASK
• SSP_FRAME_TYPE_VENDOR
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Wait Commands
Syntax: WAIT_FOR { <command1> <command2> ... <group1> <group2> ... } 

WaitCommand Name Description

WF_TIMEOUT  Timeout Credit 
Available 
When WF_TIMEOUT is 
requested in WAIT_FOR 
command the wait session 
will be released after timeout 
has elapsed. 

The Timeout value can be set 
two different ways:
1. Through the global Wait-

Timeout setting that can 
appear anywhere in genera-
tion. Default value is 1000 
microseconds. Syntax:

     Set WaitTimeout = 
<value> (in microseconds) 

  2. Through local WaitTime-
out value for this specific 
wait session. Syntax: 

     WAIT_FOR ( 
<number_of_microseconds
> ) { WF_TIMEOUT 
<other_wait_commands> } 
In this case wait for other 
commands will be released 
no later then after 
number_of_microseconds, 
but global WaitTimeout 
value remains unchanged 
for future use. 

See Generation\Include\
WaitCommands.inc in your 
SASTracer program folder 
for the samples of syntax. 

WF_SOF   primitive

WF_EOF   primitive

WF_SOAF   primitive

WF_EOAF   primitive

WF_ACK   primitive

WF_NAK_CRC_ERROR   primitive

WF_NAK_RESERVED_0   primitive

WF_NAK_RESERVED_1   primitive
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WF_NAK_RESERVED_2   primitive

WF_CREDIT_AVAIL  Credit Available
This function is based on a 
10-bit counter whose value 
can range  from -512 to +511 
(twos-complement). This 
counter is cleared  by sending 
or receiving an 
OPEN_ACCEPT primitive, 
or by  execution of a 
CLEAR_CREDIT_AVAIL 
command in the script. 

This counter is incremented 
by receiving any SAS RRDY 
primitive and is decremented 
by sending SAS SOF. The 
wait_for command will wait 
for this counter to have a pos-
itive value between +1 and  
+511. This wait_for condition 
is intended to be used before 
sending a SAS frame within a 
connection.
ClEAR_CREDIT_AVAIL 
clears this credit function.

WF_CREDIT_BLOCKED_RECEIVED CreditBlocked 
Received
This function is based on a 
flip-flop which is cleared by 
sending or  receiving an 
OPEN_ACCEPT primitive. It 
is set by receiving a  
CREDIT_BLOCKED primi-
tive. It is intended to be used 
in conjunction  with 
wf_credit_avail to prevent 
script hangs in those cases 
where there  is not going to 
be any more credit granted. 

WF_CREDIT_BLOCKED   primitive

WF_RRDY_NORMAL   primitive

WF_RRDY_RESERVED_0   primitive

WF_RRDY_RESERVED_1   primitive

WaitCommand Name Description
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WF_BREAK   primitive

WF_CLOSE_CLEAR_AFFILIATION   primitive

WF_CLOSE_NORMAL   primitive

WF_CLOSE_RESERVED_0   primitive

WF_CLOSE_RESERVED_1   primitive

WF_DONE_ACK_NAK_TIMEOUT   primitive

WF_DONE_CREDIT_TIMEOUT   primitive

WF_DONE_NORMAL   primitive

WF_DONE_RESERVED_0   primitive

WF_DONE_RESERVED_1   primitive

WF_DONE_RESERVED_TIMEOUT_0   primitive

WF_DONE_RESERVED_TIMEOUT_1   primitive

WF_ERROR   primitive

WF_HARD_RESET   primitive

WF_AIP_NORMAL   primitive

WF_AIP_RESERVED_0   primitive

WF_AIP_RESERVED_1   primitive

WF_AIP_RESERVED_2   primitive

WF_AIP_RESERVED_WAIT_ON_PART   primitive

WF_AIP_WAIT_ON_CONN   primitive

WF_AIP_WAIT_ON_DEVICE   primitive

WaitCommand Name Description
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WF_AIP_WAIT_ON_PARTIAL   primitive

WF_IDENTIFY_FRAME   Identify Address  
Frame

WF_OPEN_FRAME   Open Address 
Frame

WF_SMP_REQUEST   SMP Request 
Frame

WF_SMP_RESPONSE   SMP Response 
Frame

WF_REC_RESOURCES_OUTPUT_A  Advanced Wait 
Condition A
This command causes gener-
ation to wait for Event "A" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WF_REC_RESOURCES_OUTPUT_B  Advanced Wait 
Condition B
This command causes gener-
ation to wait for Event "B" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WF_REC_RESOURCES_OUTPUT_C  Advanced Wait 
Condition C
This command causes gener-
ation to wait for Event "C" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WaitCommand Name Description
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WF_REC_RESOURCES_OUTPUT_D  Advanced Wait 
Condition D
This command causes gener-
ation to wait for Event "D" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WF_REC_RESOURCES_OUTPUT_E  Advanced Wait 
Condition E
This command causes gener-
ation to wait for Event "E" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WF_REC_RESOURCES_OUTPUT_F  Advanced Wait 
Condition F
This command causes gener-
ation to wait for Event "F" to 
occur that you defined in the 
Generation Options dialog 
described at the end of this 
chapter.

WF_COMRESET_COMINIT   COMRESET OOB 
Signals

WF_COMSAS   COMSAS OOB 
Signals

WF_COMWAKE   COMWAKE OOB 
Signals

WF_BLOCK1_MISC_RESERVED_0    reserved 

WF_BLOCK1_MISC_RESERVED_1    reserved 

WF_BLOCK1_MISC_RESERVED_2    reserved 

WF_BLOCK1_MISC_RESERVED_3    reserved 

WF_BLOCK1_MISC_RESERVED_4    reserved 

WaitCommand Name Description
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WF_SATA_CONT   primitive

WF_SATA_DMAT   primitive

WF_SATA_EOF   primitive

WF_SATA_ERROR   primitive

WF_SATA_HOLD   primitive

WF_SATA_HOLDA   primitive

WF_SATA_PMACK   primitive

WF_SATA_PMNAK   primitive

WF_SATA_PMREQ_P   primitive

WF_SATA_PMREQ_S   primitive

WF_SATA_R_ERR   primitive

WF_SATA_R_IP   primitive

WF_SATA_R_OK   primitive

WF_SATA_R_RDY   primitive

WF_SATA_SOF   primitive

WF_SATA_SYNC   primitive

WF_SATA_WTRM   primitive

WF_SATA_X_RDY   primitive

WF_OPEN_ACCEPT   primitive

WF_OPEN_REJECT_BAD_DESTINATION   primitive

WF_OPEN_REJECT_CONN_RATE_NOT_SUPPORTED   primitive

WF_OPEN_REJECT_NO_DESTINATION   primitive

WF_OPEN_REJECT_PATHWAY_BLOCKED   primitive

WF_OPEN_REJECT_PROTOCOL_NOT_SUPPORTED   primitive

WF_OPEN_REJECT_RETRY   primitive

WaitCommand Name Description
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 WF_OPEN_REJECT_STP_RESOURCES_BUSY   primitive

WF_OPEN_REJECT_WRONG_DESTINATION   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_0   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_1   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_2   primitive

WF_OPEN_REJECT_RESERVED_ABANDON_3   primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_0   primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_1   primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_0   primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_1   primitive

WF_OPEN_REJECT_RESERVED_STOP_0   primitive

WF_OPEN_REJECT_RESERVED_STOP_1   primitive

WF_ALIGN_0   primitive

WF_ALIGN_1   primitive

WF_ALIGN_2   primitive

WF_ALIGN_3   primitive

WF_NOTIFY_ENABLE_SPINUP   primitive

WF_NOTIFY_RESERVED_0   primitive

WF_NOTIFY_RESERVED_1   primitive

WF_NOTIFY_RESERVED_2   primitive

WF_BROADCAST_CHANGE   primitive

WF_BROADCAST_RESERVED_0   primitive

WF_BROADCAST_RESERVED_1   primitive

WaitCommand Name Description
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Wait Command Groups
 

WF_BROADCAST_RESERVED_2   primitive

WF_BROADCAST_RESERVED_3   primitive

WF_BROADCAST_RESERVED_4   primitive

WF_BROADCAST_RESERVED_CHANGE_0   primitive

WF_BROADCAST_RESERVED_CHANGE_1   primitive

WF_BLOCK2_MISC_RESERVED_0    reserved 

WF_BLOCK2_MISC_RESERVED_1    reserved 

Wait Command Group  Group Contents

WF_ALL_SOF  
 

WF_SOF   

WF_SOAF 

WF_ALL_EOF  WF_EOF   

WF_SOAF 

WF_NAK  WF_NAK_CRC_
ERROR   

WF_NAK_
RESERVED_0   

WF_NAK_
RESERVED_1   

WF_NAK_
RESERVED_2  

WaitCommand Name Description
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WF_RRDY  WF_RRDY_
NORMAL   

WF_RRDY_
RESERVED_0   

WF_RRDY_
RESERVED_1  

WF_CREDIT_OK  WF_CREDIT_
AVAIL   

WF_CREDIT_BLO
CKED_RECEIVED  

WF_CLOSE  WF_CLOSE_CLEA
R_AFFILIATION   

WF_CLOSE_
NORMAL   

WF_CLOSE_
RESERVED_0   

WF_CLOSE_
RESERVED_1  

Wait Command Group  Group Contents
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WF_DONE  WF_DONE_ACK_
NAK_TIMEOUT   

WF_DONE_
CREDIT_
TIMEOUT   

WF_DONE_
NORMAL   

WF_DONE_
RESERVED_0   

WF_DONE_
RESERVED_1   

WF_DONE_
RESERVED_
TIMEOUT_0   

WF_DONE_
RESERVED_
TIMEOUT_1  

Wait Command Group  Group Contents
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WF_AIP  WF_AIP_NORMAL   

WF_AIP_
RESERVED_0   

WF_AIP_
RESERVED_1   

WF_AIP_
RESERVED_2   

WF_AIP_
RESERVED_WAIT
_ON_PART   

WF_AIP_WAIT_
ON_CONN   

WF_AIP_WAIT_
ON_DEVICE   

WF_AIP_WAIT_
ON_PARTIAL  

WF_REC_RESOURCES  WF_REC_
RESOURCES_
OUTPUT_A   

WF_REC_
RESOURCES_
OUTPUT_B   

WF_REC_
RESOURCES_
OUTPUT_C   

WF_REC_
RESOURCES_
OUTPUT_D   

WF_REC_
RESOURCES_
OUTPUT_E   

WF_REC_
RESOURCES_
OUTPUT_F  

Wait Command Group  Group Contents
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WF_RCV_STATUS  
  

WF_SATA_R_ERR

WF_SATA_R_OK

WF_PM_REQ  
  

WF_SATA_
PMREQ_P   

WF_SATA_
PMREQ_S

WF_PM_STATUS  
  

WF_SATA_
PMACK   

WF_SATA_
PMNAK

Wait Command Group  Group Contents
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WF_OPEN_REJECT  WF_OPEN_REJEC
T_BAD_DESTINA
TION   

WF_OPEN_
REJECT_CONN_
RATE_NOT_
SUPPORTED   

WF_OPEN_
REJECT_NO_
DESTINATION   

WF_OPEN_
REJECT_
PATHWAY_
BLOCKED   

WF_OPEN_
REJECT_
PROTOCOL_NOT_
SUPPORTED   

WF_OPEN_
REJECT_RETRY   

WF_OPEN_
REJECT_STP_
RESOURCES_
BUSY   

WF_OPEN_
REJECT_WRONG_
DESTINATION   

WF_OPEN_
REJECT_
RESERVED_
ABANDON_0   

WF_OPEN_
REJECT_
RESERVED_
ABANDON_1   

WF_OPEN_
REJECT_
RESERVED_
ABANDON_2   

Wait Command Group  Group Contents
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WF_OPEN_RESPONSE  
  

WF_OPEN_
ACCEPT   

WF_OPEN_
REJECT

WF_ALIGN  WF_ALIGN_0   

WF_ALIGN_1   

WF_ALIGN_2   

WF_ALIGN_3  

WF_NOTIFY  WF_NOTIFY_
ENABLE_SPINUP   

WF_NOTIFY_
RESERVED_0   

WF_NOTIFY_
RESERVED_1   

WF_NOTIFY_
RESERVED_2  

Wait Command Group  Group Contents
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Generation Settings

WF_BROADCAST  WF_BROADCAST_
CHANGE   

WF_BROADCAST_
RESERVED_0   

WF_BROADCAST_
RESERVED_1   

WF_BROADCAST_
RESERVED_2   

WF_BROADCAST_
RESERVED_3   

WF_BROADCAST_
RESERVED_4   

WF_BROADCAST_
RESERVED_
CHANGE_0   

WF_BROADCAST_
RESERVED_
CHANGE_1  

Table 2: Generation Settings

Setting Default 
Value Description 

Global Settings

GenerationMode    >>>>>   Generation Mode - must be 
defined or no generation will 
take place.  Possible Values:  
GEN_MODE_SATA_HOST  
GEN_MODE_SATA_DEVICE  
GEN_MODE_SAS_INITIATOR  
GEN_MODE_SAS_TARGET  
Default Value:  
GEN_MODE_ERROR - undefined 
mode 

Wait Command Group  Group Contents
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SSC    0   Spread Spectrum Clocking 
mode for SATA. Can only be 
set outside Generation block. 

MultiSpeedMode    0  When set, the change of 
speed within Generation 
block is allowed with follow-
ing syntax: set Speed = 
LINK_SPEED_1_5G / 
LINK_SPEED_3G. 

AutoMode Settings

AutoOOBMode   0 When set, the generator will 
go through the stages of 
bringing up the link automat-
ically, including waiting for 
and responding to the device 
or host it is connected to. 

AutoHoldMode    0  When set, the generator will 
respond automatically to 
Hold requests. Not sup-
ported for version 1.1 
(reserved). 

AutoDMAT    0  When set, the generator will 
respond automatically to 
DMAT requests. Not sup-
ported for version 1.1 
(reserved). 

AutoHandshake    0  When set, the generator will 
respond automatically to 
TBD commands. Not sup-
ported for version 1.1 
(reserved). 

Table 2: Generation Settings

Setting Default 
Value Description 
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AutoSpeedNeg    0  When set, the generator will 
automatically go throughthe 
speed negotiation process, 
for the speed set in the 
PINTERFACEC_SERDES 
register for the Trainer. 

AutoAlignSATA    0  When set, the generator will 
automatically inserting the 
stream 2 Align(0) primitives 
every 254 dwords, as speci-
fied in the SATA spec. 

AutoAlignSAS    0  When set, the generator will 
automatically inserting the 
stream Align primitives 
every 2048 dwords, as speci-
fied in the SAS spec.Two 
Align modes can be turned 
on simultaneously, to support 
STP

COMINIT Settings

COMINIT_NegLen    800  The number of bursts to send 
as part of this OOB 
type.Each Burst is followed 
by an Idle. The Burst-Idle 
pairs are repeated the 
requested number of times, 
and then followed by the 
Negation_length of Idle. 

COMINIT_IdleLen    480  Burst time between each 
OOB idle in OOBIs.During 
the specified period, the gen-
erator will send ALIGN(0) at 
the specified speed. 

Table 2: Generation Settings

Setting Default 
Value Description 
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COMINIT_BurstLen    160  Idle time between each OOB 
burst in OOBIs.During the 
specified period, the genera-
tor will keep the line at elec-
tric idle. 

COMINIT_NumBursts    6  Negation time at the end of 
the OOB signal in 
OOBIs.During the specified 
period, the generator will 
keep the line at electric idle. 

COMWAKE Settings

COMWAKE_NegLen    280  The number of bursts to send 
as part of this OOB 
type.Each Burst is followed 
by an Idle. The Burst-Idle 
pairs are repeated the 
requested number of times, 
and then followed by the 
Negation_length of Idle. 

COMWAKE_IdleLen    160  Burst time between each 
OOB idle in OOBIs.During 
the specified period, the gen-
erator will send ALIGN(0) at 
the specified speed. 

COMWAKE_BurstLen    160  Idle time between each OOB 
burst in OOBIs.During the 
specified period, the genera-
tor will keep the line at elec-
tric idle. 

COMWAKE_NumBursts    6  Negation time at the end of 
the OOB signal in 
OOBIs.During the specified 
period, the generator will 
keep the line at electric idle. 

Table 2: Generation Settings

Setting Default 
Value Description 
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COMSAS Settings

COMSAS_NegLen    2400  The number of bursts to send 
as part of this OOB 
type.Each Burst is followed 
by an Idle. The Burst-Idle 
pairs are repeated the 
requested number of times, 
and then followed by the 
Negation_length of Idle. 

COMSAS_IdleLen    1440  Burst time between each 
OOB idle in OOBIs.During 
the specified period, the gen-
erator will send ALIGN(0) at 
the specified speed. 

COMSAS_BurstLen    160  Idle time between each OOB 
burst in OOBIs.During the 
specified period, the genera-
tor will keep the line at elec-
tric idle. 

COMSAS_NumBursts    6  Negation time at the end of 
the OOB signal in 
OOBIs.During the specified 
period, the generator will 
keep the line at electric idle. 

SATA Link Init Settings

OOB_SATA_D102_Time    100000  D10.2 time for SATA link 
synchronization in 
OOBIs.During the specified 
period, the generator will 
transmit D10.2 symbols. 

Table 2: Generation Settings

Setting Default 
Value Description 
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OOB_SATA_Align_Time    100000  ALIGN(0) time for SATA 
link synchronization in 
OOBIs.During the specified 
period, the generator will 
transmit ALIGN(0) primi-
tives. 

SAS Speed Negotiation Settings

OOB_SAS_Align1_Time    81920  ALIGN(1) time for SAS 
speed negotiation in 
OOBIs.During the specified 
period, the generator will 
transmit ALIGN(1) primi-
tives. 

OOB_SAS_Align0_Time    81920  ALIGN(0) time for SAS 
speed negotiation in 
OOBIs.During the specified 
period, the generator will 
transmit ALIGN(0) primi-
tives. 

OOB_SAS_Interspeed_Time    750000  Interspeed time for SAS 
speed negotiation in 
OOBIs.During the specified 
period, the generator will 
keep the line at electric idle. 

Table 2: Generation Settings

Setting Default 
Value Description 
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SATA Speed Negotiation Settings

OOB_SpeedNeg_RCDT    750000  Maximum time in OOBIs 
during the speed negotiation 
window for a transmitter to 
reply with ALIGN(1). 

OOB_SpeedNeg_SNTT    163840  Time in OOBIs during which 
ALIGN(0) or ALIGN(1) is 
transmitted at each physical 
link rate during the speed 
negotiation sequence. 

OOB_SpeedNeg_SNLT    153600  Time in OOBIs during which 
the transmitter shall transmit 
idle between rates during 
speed negotiation. 

Speed Settings

Speed    >>>>>   Link Speed  Possible Val-
ues:  LINK_SPEED_1_5G  
LINK_SPEED_3G  Default 
Value:  LINK_SPEED_1_5G

RateMatching    0  When set, the generator will 
automatically inserting the 
stream Align(0) primitive 
after every dword. 

Table 2: Generation Settings

Setting Default 
Value Description 
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Scrambling Mode Settings

ScramblingMode    >>>>>   Raw Data Scrambling Mode 
- Only those raw dwords will 
be scrambled that contain 
only data bytes (no 10bit 
symbols or 'K' bytes. Scram-
bling is reset by changing 
ScramblingMode or by any 
valid SAS or SATA frame.  
Possible Values:  
SCRAMBLING_MODE_NONE  
SCRAMBLING_MODE_SAS  
SCRAMBLING_MODE_SATA  
Default Value:  
SCRAMBLING_MODE_NONE

Wait Timeout Settings

WaitTimeout    1000  Sets global WaitTimeout 
value in microseconds 

AUTO_WAIT_SAS_AFTER Settings

AUTO_WAIT_SAS_AFTER_
CLOSE_FOR_CLOSE  

  FALSE  When set, the generator will 
insert WAIT_FOR CLOSE 
command immediately after 
each CLOSE primitive. 

AUTO_WAIT_SAS_AFTER_EOF_
FOR_ACK  

  FALSE  When set, the generator will 
insert WAIT_FOR ACK 
command immediately after 
each EOF primitive. 

AUTO_WAIT_SAS_AFTER_EOF_
FOR_ACK_OR_NAK  

  FALSE  When set, the generator will 
insert WAIT_FOR ACK or 
NAK command immediately 
after each EOF primitive. 

Table 2: Generation Settings

Setting Default 
Value Description 
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AUTO_WAIT_SAS_AFTER_
OPEN_FOR_OPEN_ACCEPT  

  FALSE  When set, the generator will 
insert WAIT_FOR 
OPEN_ACCEPT command 
immediately after each Open 
Address Frame. 

AUTO_WAIT_SAS_AFTER_
OPEN_FOR_OPEN_REJECT  

  FALSE  When set, the generator will 
insert WAIT_FOR 
OPEN_REJECT command 
immediately after each Open 
Address Frame. 

AUTO_WAIT_SAS_AFTER_
IDENTIFY_FOR_IDENTIFY_
FRAME  

  FALSE  When set, the generator will 
insert WAIT_FOR Identify 
Frame command immedi-
ately after each Identify 
Address Frame. 

AUTO_WAIT_SAS_AFTER_SMP
_REQ_FOR_RESP  

  FALSE  When set, the generator will 
insert WAIT_FOR SMP 
Response Frame command 
immediately after each SMP 
Request Frame. 

AUTO_WAIT_SAS_BEFORE Settings

AUTO_WAIT_SAS_BEFORE_
CLOSE_FOR_CLOSE  

  FALSE  When set, the generator will 
insert WAIT_FOR CLOSE 
command right before each 
CLOSE primitive. 

AUTO_WAIT_SAS_BEFORE_
SOF_FOR_CREDIT  

  FALSE  When set, the generator will 
insert WAIT_FOR CREDIT 
command right before each 
SOF primitive. 

AUTO_WAIT_SAS_BEFORE_
IDENTIFY_FOR_IDENTIFY_
FRAME 

  FALSE  When set, the generator will 
insert WAIT_FOR Identify 
Frame command right before 
each Identify Address Frame. 

Table 2: Generation Settings

Setting Default 
Value Description 
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 AUTO_WAIT_SAS_BEFORE_
OPEN_ACCEPT_FOR_OPEN  

  FALSE  When set, the generator will 
insert WAIT_FOR Open 
Frame command right before 
each OPEN_ACCEPT primi-
tive. 

 AUTO_WAIT_SAS_BEFORE_
OPEN_REJECT_FOR_OPEN  

  FALSE  When set, the generator will 
insert WAIT_FOR Open 
Frame command right before 
each OPEN_REJECT primi-
tive. 

 
AUTO_WAIT_SAS_BEFORE_AIP
_FOR_OPEN  

  FALSE  When set, the generator will 
insert WAIT_FOR Open 
Frame command right before 
each primitive of AIP group. 

AUTO_WAIT_SAS_BEFORE_
SMP_RESP_FOR_REQ  

  FALSE  When set, the generator will 
insert WAIT_FOR SMP 
Request Frame command 
right before each SMP 
Response Frame. 

AUTO_WAIT_SATA_AFTER Settings

AUTO_WAIT_SATA_AFTER_X_
RDY_FOR_R_RDY  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_R_RDY command 
immediately after each case 
of SATA_CONT primitive 
following SATA_X_RDY 
primitive. 

AUTO_WAIT_SATA_AFTER_
WTRM_FOR_STATUS  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_R_ERR or 
SATA_R_OK command 
immediately after each case 
of SATA_CONT primitive 
following SATA_WTRM 
primitive. 

Table 2: Generation Settings

Setting Default 
Value Description 
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AUTO_WAIT_SATA_AFTER_PM
REQ_S_FOR_RESPONSE  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_PMACK or 
SATA_PMNAK command 
immediately after each case 
of SATA_CONT primitive 
following SATA_PMREQ_S 
primitive. 

AUTO_WAIT_SATA_AFTER_PM
REQ_P_FOR_RESPONSE  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_PMACK or 
SATA_PMNAK command 
immediately after each case 
of SATA_CONT primitive 
following SATA_PMREQ_P 
primitive. 

 AUTO_WAIT_SATA_AFTER_
SYNC_FOR_SYNC  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_SYNC command 
immediately after each case 
of SATA_CONT primitive 
following SATA_SYNC 
primitive. 

AUTO_WAIT_SATA_BEFORE Settings

AUTO_WAIT_SATA_BEFORE_
PMACK_FOR_PMREQ  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_PMREQ_S or 
SATA_PMREQ_P com-
mand right before each 
SATA_PMACK primitive. 

AUTO_WAIT_SATA_BEFORE_
PMNAK_FOR_PMREQ  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_PMREQ_S or 
SATA_PMREQ_P com-
mand right before each 
SATA_PMNAK primitive. 

Table 2: Generation Settings

Setting Default 
Value Description 
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12.6  Setting Complex "Wait For" Conditions
The Generation Options dialog lets users define complex "Wait For" events 
and assign a letter value ("A" through "F") to the definition so that you can 
refer to the definition by letter instead of by textual name.  

Once a letter value has been assigned to an event, the letter is referred to in 
your generation script using the following command syntax:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}

where "A," in this case, is the defined condition.

AUTO_WAIT_SATA_BEFORE_
RERR_FOR_WTRM  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_R_ERR command 
right before each 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_BEFORE_
ROK_FOR_WTRM  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_R_OK command 
right before each 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_BEFORE_RI
P_FOR_SOF  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_R_IP command right 
before each SATA_SOF 
primitive. 

AUTO_WAIT_SATA_BEFORE_
R_RDY_FOR_X_RDY  

  FALSE  When set, the generator will 
insert WAIT_FOR 
SATA_X_RDY command 
right before each 
SATA_R_RDY primitive. 

Table 2: Generation Settings

Setting Default 
Value Description 
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Setting Conditions with the Generation Options Dialog
To set a complex condition, open the Generation Options dialog: 

Step 1 Select Generate > Generation Options from the menu.  
The Generation Options dialog opens.  The Generation 
Options dialog looks very similar to the Recording Rules 
dialog:  

Step 2 Click the New Events button and select an event from the menu.  
The selected event should appear in the Available Events area 
along the left side of the dialog box.

Step 3 Drag the new event button to the Global State cell.

Step 4 Right-click on the new event button and select Specify Action(s).  
A menu appears showing the letters A through F and the option 
"No action."
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Step 5 Select a letter from the menu.  
The menu closes.  The event 
button should now point to a 
neighboring button that has the 
letter value you assigned.  

Step 6 Once the condition has been defined, you can then add the 
Wait For command line (with whatever letter you assigned) 
to your script.  For example:
Wait_For {WF_REC_RESOURCES_OUTPUT_A}
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13.  Updates and Licensing
From time to time as modifications are made to the SATracer/Trainer 
Analyzer, it may become necessary to update the SATracer/Trainer 
software.  You can obtain new software from the LeCroy website:  

www.lecroy.com  
When you download new SASTracer software, firmware and BusEngine 
files are included as part of the software package.  Occasionally, LeCroy 
will update these files.  The new files will install automatically following 
installation of the new analyzer software.  If you prefer, however, you can 
manually update firmware and BusEngine. This chapter describes both 
automatic and manual updates.

Note: LeCroy analyzers come with a Three Year Investment 
Protection Agreement that entitles users to new software.  
Thereafter, to obtain new software the user will need to renew 
the LeCroy Maintenance Agreement.  Contact LeCroy for 
details.

13.1  Software, Firmware, and BusEngine Versions
The Readme.txt file on the installation CD and on the installed directory on 
your hard drive gives last-minute updates about the current release. Included 
with each release are the most recent downloadable images of the Firmware 
and the BusEngine. 

Once the SATracer/Trainer Analyzer has completed the self diagnostics 
and is connected to the PC, you can check the latest version of the software 
and BusEngine.

To check information about the current software, select 
About SASTracer… from the Help menu.

The About SASTracer window appears.

About SASTracer details revisions of the following software and 
hardware:

• SATracer/Trainer Software Version, Build Number
• SATracer/Trainer Firmware Version
• BusEngine Version, Build Number
• Unit Serial Number
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Note: When contacting LeCroy for technical support, please have 
available all the revisions reported in the About SASTracer 
window.

13.2  Software Updates
When a new software release is available, it is posted on the Support page 
of the LeCroy website at www.LeCroy.com/support.html.

To update the software, follow these steps:

Step 1 Find the latest released software version on the LeCroy website 
under Support.

If you are running the latest version of the software, no further 
action is needed. 
If you are not running the latest version, continue to Step 3.

Step 2 Download the Zip file from the website.

Step 3 Unzip the files into your choice of directory.

Step 4 Click Start, then Run, and browse to where you unzipped 
the files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the 
installation.

Step 8 Read the Readme file for important information on changes 
in the release.
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13.3  Automatic BusEngine and Firmware Updates
BusEngine and Firmware updates often need to be performed when you 
update the SATracer/Trainer software. These updates can be performed 
automatically or manually. Both processes are described.

Updating the BusEngine
The BusEngine core is the heart of the SATracer/Trainer Analyzer. Using 
FPGA technology, it incorporates both the high speed recording engine and 
the configurable building blocks that implement data/state/error detections, 
triggering, capture filtering, external signal monitoring, and event counting 
and sequencing. Both the BusEngine program and the Firmware that 
manages the internal microcontroller are fully field updateable.

Within a new software release, it may be necessary to update the Analyzer’s 
BusEngine hardware for proper operation. The Readme file lets you know 
if this is necessary. 

Updating the Firmware
Within a new software release, it may also be necessary to update the 
Analyzer’s firmware for proper operation. The Readme file informs you if 
this is necessary. 

Automatic Updates
When the SATracer/Trainer software is updated, the software may become 
incompatible with the BusEngine and Firmware. If a recording is attempted, 
SATracer/Trainer displays an error message and then automatically begins 
an update process for the BusEngine and Firmware. 

To perform an automatic BusEngine and Firmware update, follow these 
steps: 

Step 1 If needed, update the SATracer/Trainer software, following the 
steps outlined in "Software Updates."

Step 2 Turn on the SATracer/Trainer Analyzer.

Step 3 Select Start > Record from the menu. 

Because the BusEngine and/or the Firmware are incompatible with 
the current SATracer/Trainer software version, an error message 
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appears showing your current versions and indicating what versions 
you need to install.

Step 4 Click Yes.

The Analyzer Setup window appears.

Step 5 Click Update.

You can select only one item at this point. If both the BusEngine 
and the Firmware need to be updated, the update will complete for 
the first item and then return to the above window so the second 
update can be performed. 

Note: Once you have started updating the BusEngine or Firmware, do 
not interrupt the update!

When the second update has finished, the following message 
appears and tells you that the update is complete. 
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Step 6 To complete the update, power cycle the SATracer/Trainer 
(turn the unit off then back on).

If you are running Windows 2000, the Analyzer will automatically 
reboot, and the following message will appear:

Step 7 Click OK.

In this instance, you do not need to power cycle the Analyzer (turn 
off then back on). 

13.4  License Information
Licensing information for SASTracer can be viewed by selecting Display 
License Information from the Help menu. The License window provides 
maintenance expiration for SASTracer. 
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13.5  Updating the Software License
A current License agreement with LeCroy entitles the analyzer owner to 
continued technical support and access to software updates as they are  
published on the LeCroy website. 

If your license expires, a License Key must be obtained by LeCroy (refer to 
the contact information at the back of this manual.) 

Once the License Key is obtained, follow these steps to install it:

Step 1 From the Help menu, select Update License. The Update License 
dialog appears. 

Step 2 Enter the path and filename for the License key or use the Browse 
button to navigate to the directory that contains the License Key. 

Step 3 Select the *.lic file, and then click Update Device.
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Appendix A:  Specifications
SATracer/Trainer is a hardware module that installs into the CATC 10K 
System. The following specifications describe a combined 
SATracer/Trainer on the CATC 10K chassis. 

Package

Power Requirements
90-254VAC, 47-63Hz (universal input), 120W maximum 

Environmental Conditions 

Probing Characteristics (model SS002MAA & SS003MAA)

Dimensions: CATC 10K: 12.2 x 12.2 x 3.5 inches 
(31.1 x 31.1 x 8.9 cm)
SASTracer Plug-in: 4.5 x 6.7 x 1.3 inches 
(11.3 x 17.0 x 3.2 cm)
SAS/SATA Exerciser Plug-in: 4.5 x 6.7 x 1.3 inches 
(11.3 x 17.0 x 3.2 cm)

Connectors: CATC 10K: 
AC power connection
External trigger connection (TRIG IN/OUT, BNC)
PC connection (USB 2.0 Hi-Speed, type "B")
Break-out board (type "D")

Weight: CATC 10K: 9.5 lbs (4.3 kg)
SASTracer Plug-in: 1 lb 11.4 oz (.77 kg)
SAS/SATA Exerciser Plug-in: 1 lb 11.4 oz (.77 kg)

Operating Range: 0 to 40 °C (32 to 104 °F)
Storage Range: -20 to 80 °C (-4 to 176 °F)
Humidity: 10 to 90%, non-condensing

Connecting Type: One Port Model - Single Pair of Internal Connectors 
(Initiator and Target; Serial ATA Standard)
Two Port Model - Dual Pair of Internal Connectors 
(Initiator and Target; Serial ATA Standard)
Four Port Model - Single Pair of Internal Connectors 
(Initiator and Target; Serial ATA Standard)

SAS/SATA Exerciser 
Connection Type:

Single Initiator and Target connectors 
(for transmission only)
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Probing Characteristics (model SS004MAA)

Recording Memory Size 
2 GBytes for trace capture, timing and control information.

Host PC Requirements 

Switches 

LEDs 

Connector Type: 2 pairs SAS External 4 lane Connector:

Non-intrusive tap - samples the signal without re-driving 
the differential lines (high value resistors contribute to 
reduction in amplitude ˜ 15%).

Repeater tap - re-drives the signal at either SAS (high 
swing) or SATA (low swing) voltages; does not re-time the 
signal.

Operating System: Windows 98SE, Windows 2000, Windows ME or 
Windows XP

Power: On/off
Manual Trigger: When pressed, triggers the end of the recording

CATC 10K: Illuminated when the analyzer is powered on.
Status (STATUS): Illuminates for approximately 25 seconds during 

initialization/power up of the UPAS base unit. If this LED 
blinks following initialization, this is an indication that 
initialization failed.

Recording (REC): Illuminated when the analyzer is actively recording traffic 
data

Triggered (TRG): Illuminated during power-on testing and when the analyzer 
has detected a valid trigger condition.

UPloading (UPLD): Illuminated when the analyzer is uploading its recording 
memory to the Host PC for displaying the CATC trace

SASTracer Plug-in 
Module:
Status (STATUS): Illuminates when there is traffic on both the host and device 

sides.  Blinks when there is traffic on one side only.
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Basic Trigger Events

Traffic Summary Reports

Frames: SSP Command, Data, Response, Task, X_RDY and 
Vendor Unique, SMP Request, Response, Report, Discover 
and Configure

Primitives: ACK, CREDIT_BLOCKED, DONE 
(ACK/NAK TIMEOUT),  NAK, RRDY, SOF,  AIP, 
BREAK, BROADCAST, CLOSE, OPEN_ACCEPT, 
OPEN_REJECT, and more task management functions  

Errors: Invalid 10b codes, CRC Errors, Running Disparity Errors, 
Time-outs, Alignment errors, Code Violation

SCSI Operations: Pending SCSI I/Os, SCSI I/O Response, SCSI I/O Latency,
SCSI I/O Throughput, Frame Length, Data Throughput,
Link Utilization (%), Frame Count

Data Frames
Primitives
Connects/Disconnects
Errors
ATA Commands
Read Response (min, max, avg.)
Write Response (min, max, avg.)
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized 
representative ("you" or "your"), fully 
complete and return the registration card 
provided with the applicable hardware product 
or peripheral hardware products (each a 
"Product") within fifteen days of the date of receipt from LeCroy or one of its 
authorized representatives, LeCroy warrants that the Product will be free from 
defects in materials and workmanship for a period of three years (the "Warranty 
Period").  You may also complete your registration form via the internet by visiting 
http://www.lecroy.com/support/register/.  The Warranty Period commences on the 
earlier of the date of delivery by LeCroy of a Product to a common carrier for 
shipment to you or to LeCroy's authorized representative from whom you purchase 
the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, 
damage during shipment after delivery to a common carrier by LeCroy, abuse, 
misuse, problems with electrical power, including power surges and outages, 
servicing not authorized by LeCroy, usage or operation not in accordance with 
Product instructions, failure to perform required preventive maintenance, software 
related problems (whether or not provided by LeCroy), problems caused by use of 
accessories, parts or components not supplied by LeCroy, Products that have been 
modified or altered by someone other than LeCroy, Products with missing or altered 
service tags or serial numbers, and Products for which LeCroy has not received 
payment in full.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408)  653-1260
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy

Protocol Solutions Group
Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

USA
Send e-mail… support@CATC.com
Visit LeCroy’s web site… http://www.lecroy.com/
 199



 SATracer/Trainer Analyzer User’s ManualLeCroy SW Version 4.6
Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty 
that are returned directly to LeCroy's facility or through LeCroy's authorized 
representatives.

How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report 
your covered warranty claim by contacting LeCroy Technical Support or its 
authorized representative.  

LeCroy Technical Support can be reached at 800-909-7112 or via email at 
support@catc.com.  You may also refer to LeCroy's website at 
http://www.lecroy.com for more information on how to contact an authorized 
representative in your region.  If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You 
must ship the Product back to LeCroy or its authorized representative, in its original 
or equivalent packaging, prepay shipping charges, and insure the shipment or 
accept the risk of loss or damage during shipment. LeCroy must receive the Product 
prior to expiration of the Warranty Period for the repair(s) to be covered.  LeCroy 
or its authorized representative will thereafter ship the repaired or replacement 
Product to you freight prepaid by LeCroy if you are located in the continental 
United States.  Shipments made outside the continental United States will be sent 
freight collect.

Please remove any peripheral accessories or parts before you ship the Product. 
LeCroy does not accept liability for lost or damaged peripheral accessories, data or 
software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new 
and/or reconditioned parts, at its sole discretion, made by various manufacturers in 
performing warranty repairs. If LeCroy repairs or replaces a Product, the Warranty 
Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product 
returned or that the returned Product is not eligible for warranty coverage, LeCroy 
will inform you of its determination.  If you thereafter request LeCroy to repair the 
Product, such labor and service shall be performed under the terms and conditions 
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of LeCroy's then current repair policy.  If you chose not to have the Product repaired 
by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU 
MAY HAVE ADDITIONAL RIGHTS THAT VARY BY JURISDICTION.  
LECROY'S RESPONSIBILITY FOR DEFECTS IN MATERIALS AND 
WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT AS SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS 
EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY 
PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES THAT 
MAY ARISE FROM ANY COURSE OF DEALING, COURSE OF 
PERFORMANCE OR TRADE USAGE.  SOME JURISDICTIONS MAY NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT OR FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT 
LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR 
FOR LOST DATA OR SOFTWARE.  LECROY'S LIABILITY TO YOU MAY 
NOT EXCEED THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM.  SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT 
APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the 
then current owner transfers ownership of the Product and notifies LeCroy of the 
transfer.  You may notify LeCroy of the transfer by writing to Technical Support at 
LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 USA or by email at: 
support@catc.com.  Please include the transferring owner's name and address, the 
name and address of the new owner, the date of transfer, and the Product serial 
number.
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